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  Introduction 3  

Introduction 

Welcome to the user guide for the DME client version 3.5.5.  

This guide is divided into three parts: 

1 An introduction to DME - about the company Excitor A/S, what the DME system 

does, and about various aspects of DME that are shared between DME clients on 

all platforms. 

2 A platform-specific guide to the DME client - for Symbian, UIQ, Windows 

Mobile, Java, iPhone, BlackBerry, and Android. 

3 A description of how you can get more help, a list of procedures, a glossary, and 

an index. This part also applies to all DME client platforms. 

Please see the "DME Deployment Guide" for information about rolling out the DME 

client to many users and for detailed installation information for each platform. 
 

Copyright information 

Copyright © 2007-11 Excitor A/S. 

All rights reserved. 

Due to continued product development, this information may change without notice. 

The information and intellectual property contained herein is confidential between 

Excitor A/S and the client, and remains the exclusive property of Excitor A/S.  

If you find any problems in the documentation, please report them to us through our 

customer support services. Excitor A/S does not warrant that this document is 

error-free. Furthermore, Excitor A/S does not warrant that the illustrations and 

screenshots used in this document reflect your version or the latest version of the 

program described. For the latest version of this product documentation, go to the 

DME website DME http://www.excitor.com. 

No part of this publication may be reproduced, stored in a retrieval system, or 

transmitted in any form or by any means, electronic, mechanical, photocopying, 

recording or otherwise without the prior written permission of Excitor A/S. 

DME, DME Sync, VoiceExtender, SmartEncrypt, and AdaptivePush are trademarks 

of Excitor A/S. 

Microsoft SQL Server, Microsoft Exchange, Windows, Windows Server 2003, and 

Active Directory are trademarks or registered trademarks of the Microsoft Corporation 

in the United States and other countries. 

Lotus Notes® and Domino® are trademarks or registered trademarks of IBM 

Corporation, registered in the U.S. and other countries. 

Apple, Apple iPhone, iPod touch, and iPad are trademarks or registered trademarks of 

Apple Inc., registered in the U.S. and other countries. 

All other trademarks are property of their respective owners. 
 

http://www.excitor.com/
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Company information 

 

12, Spotorno Allé 

2630 Taastrup 

Denmark 

 

Phone: +45 70 21 68 00 

E-mail: mail@excitor.com 

Website: DME http://www.excitor.com 
 

About DME 

DME (Dynamic Mobile Exchange) offers synchronization of push e-mail, PIM 

information (calendar, contacts, to-dos), and optionally files, to mobile devices. It 

fully integrates mobile device management with state-of-the-art security and efficient 

software deployment. DME is a mobile client/server solution that works with mobile 

phones, smartphones and PDAs using Symbian, Windows Mobile, Java or iPhone*) as 

operating system. DME is developed by Excitor A/S. 

The solution enables large and midsize enterprises to deliver business mobility 

services to employees and to effectively manage and control mobile devices without 

compromising security. DME is device, network and operator independent and offers 

unparalleled TCO, unprecedented data and device security, and a very intuitive 

interface for users and administrators. 

*) Please note that due to limitations on the iPhone platform, not all server features 

are supported on the DME client for iPhone. 
 

http://www.excitor.com/
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Features and benefits 
 Convenient for the user: Push e-mail, calendar, contacts and to dos 

With DME on your mobile phone, smartphone, or PDA, you get your most critical 

and often used office tools in your pocket wherever you are, whenever you need it. 

E-mails appear on your phone the moment they hit your office mailbox.  

 Quickly back in the game: Instant service recovery 

Should your phone get lost or stolen, a new DME client can be pushed to a new 

phone in a few minutes after you purchase a new DME supported phone or borrow 

one from someone else – no matter where it happens. 

 Fretless security: Mobile security policy enforcement 

E-mails are encrypted over the air and on the device itself using full encryption 

(AES 128-bit or stronger). Shell protection of the entire phone, requiring domain 

password to access all features except picking up calls, gives you further security 

options. 

 Freedom and ease-of-use: Effective control of all devices 

Gain a complete overview of your devices – regardless of make, model, or 

platform. Information about the device model, versions and programs installed on 

the device is listed in the Web-based DME control center for easy administration. 

Features, settings and available applications and network connections are all 

controlled centrally and can only be changed by the users to the extent this is 

allowed by centrally applied security policies. Dividing the devices into groups 

makes it easy to change settings/features for many devices at a time. 

 Ease-of-use comes in many flavors: Simple support and administration 

Push software and upgrades via SMS or WAP to the users, permit them to serve 

themselves, or automatically upgrade software when the users log on. For support 

purposes, retrieval of device configurations and connection set-up makes it 

possible for you to help users who cannot connect, and a log of user actions assists 

you in identifying the problems and solving them. Notification of changes to 

server status can be sent to the DME administrators to ensure they are alerted to 

problems quickly. 

 Cost containment: Control of ongoing mobile cost 

Data and voice logging allows you to monitor activity levels real-time, and 

identify “expensive” behavior which can be reduced. Heavily-used operators can 

be determined and connection preferences can be set as default. Build advanced 

reports to get a clear view of your organization’s mobile traffic using the 

integrated BI reporting tools. 

 Freedom of choice: Versatility 

Works on any available network (WLAN/Wi-Fi, GSM, GPRS, 3G/UMTS, 

EDGE...), operator, and on most devices from leading manufacturers. Works on 

Lotus Domino and/or Microsoft Exchange collaboration systems. 

Please note that the above applies to the full DME client. Note also that due to 

limitations specific to the iPhone platform, a few of the features mentioned above are 

not supported on DME for iPhone. 
 

Typographical conventions 

This guide uses special formating to signify that a text has a special meaning. The 

following kinds of formatting is used: 
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Formatting Type of information 

Bold Interface elements that you can select, such as menu 

options or command buttons. 

Special Bold Items that can be selected from a list of options, or text 

that you must type. 

Emphasis Applies emphasis to a point, and is also used for 

variable expressions such as parameters. 

Key+Key Key combinations where the user must press and hold 

down one key and then press another, for example, 

Ctrl+P or Alt+F4. 

 
Caution - performing the action described may lead to 

loss of data or involves other risk. 

For an explanation of specialized terms used in the documentation, see the Glossary at 

the end of this document. 
 

Terminology 

The following is a list of terms used in this guide, and an explanation of the term. 

Term Explanation 

DME Often used for the DME Client. 

DME Server The DME Web Administration Interface. 

Collaboration system The server-based e-mail and calendar system that your 

company runs - either Lotus Domino (with Lotus Notes as 

the user front-end) or Microsoft Exchange (with Microsoft 

Outlook). 

DME menu The DME menu is the main menu in the DME interface. 

On some devices, you have to select Options to access the 

menu, on some you select More. 

Select To choose an item or a menu option, whether by clicking, 

tapping, or choosing in a menu. 

The features or interface elements mentioned in this first part of the user guide apply 

to all phone platforms, and may be illustrated by images from any of the supported 

platforms: Java, Symbian, UIQ, Windows Mobile, or iPhone. The following icons are 

used to signify platforms: 

Icon Platform 

 

Applies to the DME Client for the Java platform. 

 

Applies to the DME Client for the Symbian platform. 

 

Applies to the DME Client for the Symbian UIQ platform. 

 Applies to the DME Client for the Windows Mobile 
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platform. 

 

Applies to the DME Client for iPhone. 

In some cases, there is more than one route to selecting an option. For instance, on 

UIQ devices you can create an e-mail either by selecting More > Create > E-mail or 

by tapping New in the touch options bar, leaving the focus on E-mail, and tapping 

OK. The manual will usually only mention the regular menu route. 
 

General client information 

The following sections contain information that is good to know before you begin to 

use DME. The issues apply to clients of all or most platforms, and deal with the 

following: 

 Time zones 

 Security 

 Synchronization and import 

 Battery conservation 

 Cost-saving features 

This information is included in all the individual client user guides as well as the 

Client Deployment Guide. 
 

Time zones 
With DME, you can always keep your office in your pocket - including your office 

calendar. One challenge with calendars is the fact that sometimes we operate with 

multiple time zones. If we travel to a different time zone, we need to make sure that 

entries in our calendar reflect the change in time zones. An appointment made for 2 

o'clock in the afternoon at your home office should be shown at 1 o'clock if you travel 

one hour west. 

The way in which DME handles time zones changed with version 3.0.2 of the 

Symbian and Java clients, and version 3.0.3 of the Windows Mobile client. DME on 

iPhone and other platforms have always worked in the "new" way. This section 

describes how the current version handles time zones; see Time zones - previous 

versions on page 8 if you are running a version of the DME client previous to the 

releases mentioned above. 

In order to keep your calendar updated this way, no matter where you are, DME uses 

the time zone setting of your device. The Region or City setting, which is part of the 

time zone specification, is used for identifying whether Daylight Savings Time (DST) 

is active or not. 

When you travel across time zones, a message from the phone operator will often tell 

you that your time zone has changed, and offer to adjust the time zone on your device 

for you. You should allow this, or adjust it yourself. If you do this, your calendar 

should remain up-to-date without excess updates being transferred between the server 

and the client. 

In a few cases, DME is unable to determine the time zone with certainty: 

 On Java devices, special considerations apply in connection with Daylight Saving 

Time (DST). The following applies to users of Sony Ericsson devices running JP-8: 



8 

 

DME Client User Guide 3.5.5 : ©2011 Excitor A/S 

 

1 Make sure that the date and time is set correctly on the phone. This is done by 

selecting Menu > Settings > Time & date > My time zone (note that Auto time 

zone must be Off). Here you must select the correct time zone and location. If your 

display does not list locations, select Options > Search region in > <Your area>. 

2 Start DME, and log in. 

3 Select Options > Settings > General, and set the time zone to match your phone 

settings. 

If you do not do this, and there is a discrepancy between the phone settings and 

your DME settings, DME will prompt you to change the DME settings when you 

log in. 

4 Select Options > Tools > Import > Calendar to do a full import of your calendar 

from the collaboration server. 

The following applies to users of Sony Ericsson devices running JP-5 and JP-7: Due 

to a limitation in the handling of time zones in JP-5 and JP-7 devices, meetings 

booked on one side of a Daylight Savings Time change may not appear correctly in 

the calendar after the DST change. 

 On Windows Mobile devices, DME only supports a limited amount of languages. 

If your device is running a language from which the DME client cannot translate the 

time zone settings, a message will ask you to select a time zone from a list. You need 

to make this selection once after the installation of DME, and once every time you 

travel. If you experience this, please contact DME support, and ask them to add your 

language to the list of known languages. 
 

Time zones - previous versions 

The following only applies if you are running one of the following versions of the 

DME client:  

 3.0.1 or earlier for Symbian (including UIQ) clients 

 3.0.1 or earlier for Java clients 

 3.0.2 or earlier for Windows Mobile clients 

When you arrive at an airport in a foreign country and turn on your device, a message 

from the phone operator will often tell you that your time zone has changed, and offer 

to adjust the time zone on your device for you. You should allow this, or adjust it 

yourself (see also the section about Java devices below). 

Now, when you start DME, DME will detect that the time zone has changed on the 

device, and ask if you want to change the time zone in DME. You should also do this. 

See General settings on page 66 for instructions how to change the time zone in 

DME. 

If you follow these simple rules: 

1 Let the device match the local time zone 

2 Let DME match the device time zone 

– then you should have no problem with duplicate or apparently missing calendar 

entries. 

The notes regarding Daylight Saving Time (DST) on Java devices also apply. See 

Time zones on page 7 above. 
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Data security 
DME has a strong focus on security. All e-mails are securely stored on the device - 

even if the SIM card is changed or the battery runs out after you have logged in. All 

data remains encrypted at all times using strong encryption, and is only decrypted to 

memory while it is displayed on screen. 

All communication with the server is encrypted, and the server can be set up to require 

a client certificate, which further prevents attempts at unauthorized access from 

devices that are unknown to the server. 

It is not possible to export any data from the device to be read elsewhere. 

All DME-related data on the device (e-mails, calendar items, to-dos, contacts, and 

synchronized files, and other data: SMS messages, data on the memory card and 

internal memory) are deleted in the following events: 

 If the SIM card is changed (if set up by the DME administrator). See Changing 

SIM cards on page 11 for more information. 

 If the user name or password is entered incorrectly a number of times (as set up by 

the DME administrator). 

 If the DME administrator decides to do it. If the device is lost or stolen, the data 

on the DME client can be cleared remotely by sending a command from the DME 

server (remote wipe). You should always contact your DME Administrator 

immediately if you lose your device. 

In case a new user logs in, all DME-related data are deleted before the Desktop or 

Inbox is shown. 
 

Changing mailbox passwords 

Depending on your company's security policy, you must change your network 

password at regular intervals. If you use Exchange, your network password is the 

same as your mailbox password, but on Domino collaboration systems this is not 

necessarily so. The DME client depends on the mailbox password to gain access to 

synchronize your e-mail to the device. 

Your mailbox password can be changed from your desktop computer or from your 

device. If your collaboration system is based on Active Directory, a message may pop 

up telling you well in advance that it is time to change your password. If you ignore 

the warning, your current password will eventually become invalid, and you will be 

unable to log on to the system. 

You can either change your password from a desktop computer on the network or 

from the DME client.  
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 If your mailbox password is changed from a desktop computer on the network, 

and you have exited DME (for instance in connection with a phone reboot) so that 

your credentials are no longer encrypted in memory, then the new password has to 

be verified on the server the first time you log in to the DME client. When you log 

in, and DME recognizes you as a user and recognizes your password, but detects 

that the password has been changed on the server, the following message is 

shown: 

 

You are then asked to enter your new password. 

1. Select Yes to verify the new password on the server. 

2. Enter your old password. 

3. Select Log in. 

You can now use DME as usual. 

 If your mailbox password is changed from a desktop computer on the network, 

and your device still has your credentials encrypted in memory: If you are logged 

in, DME will log you out the first time the device communicates with the server 

(for instance in connection with a network push). When you log in again, you 

should use your new password. DME will assume that you have changed password 

on the server, verify your new password, and re-encrypt your credentials without 

you having to confirm any messages. 

 You can change your mailbox password from the client.  

1. Log in to the client as usual. 

2. Open the DME menu, and select Tools > Change password. 

3. Enter your existing password in the Old password field. 

4. Enter a new password in the New password field, and retype it in the 

Confirm new password field. 

5. Select Change. 
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DME sends the password change request to the server. If the server accepts the 

request, a message tells you that your password has been changed. If the server 

rejects the request, a message tells you why the command failed. If the command 

fails, it can be an issue with the server setup, and you should contact your DME 

Administrator. 
 

Switching users 

Unless forbidden by the DME Administrator, you can hand over your device to 

another person, even if it contains all your DME data. All e-mails,  calendar items, 

to-do items, contacts, and synchronized files will be erased when the new user logs in. 

The new user is taken through the same verification process as described in Logging 

in on page 24. 
 

Changing SIM cards 

If you change the SIM card in your device, the DME client will ask for the new phone 

number the first time you log in to the DME client. It is important that the phone 

number is correct, as many features depend on the DME server's ability to send 

commands by SMS to the device. 

 

1 Enter the phone number. 

2 Select OK. 

The device phone number can also be changed in the general settings (see General 

settings on page 66). 

Depending on the setting Action on SIM card change in the security settings, your 

DME data will be wiped from the device when you change the SIM card, or your 

device will be locked, or you are allowed to log in as usual. 

 

On Java, this feature is only supported by the DME client under 

certain conditions. 

For more information, see Security settings on page 68 in the Java Client User Guide.  

 

This feature does not apply to iPhone. 

 
 

Logging in using a PIN code 

If your company maintains strict security rules, you may be required to enter a long, 

complex password with a mix of letters and special symbols to gain access to the 

network and collaboration system. This may be easy to enter on a full PC keyboard, 

but you might find it difficult to enter using your phone keypad. 
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Instead of using your collaboration system password for logging in, it is possible to 

substitute the password for a PIN code of your choice. The DME administrator can set 

a minimum length for the PIN code (4 to 10 letters and numbers), but you are free to 

define a PIN code that is easier to enter using the keypad. 

In order to maintain high security on the device, the following special conditions apply 

when using the PIN code instead of the regular password: 

 The PIN code defined by you may expire after some time. The validity period of 

the PIN code is set by the DME administrator, and could for instance be 8 hours, 

corresponding to one working day. The validity period begins when you log in to 

DME using your regular password. After this, you can use your PIN code to log in 

to DME, until the validity period runs out. Then you have to use your regular 

password again in order to reset the validity period. You do not have to change the 

PIN code. 

The administrator may choose to allow a PIN code that never expires, but this is 

not recommended. 

 If you attempt to log in using your PIN code, but you enter the PIN code wrong, 

then you have to use your regular password for your next attempt. Your PIN code 

is not invalidated, however - you can use it the next time you log in to DME. 

Note that the feature may be disabled by the DME administrator for security reasons. 

 Substituting password for PIN code 

1 Log in to the DME client using your regular collaboration system password. 

2 Select Tools > Set PIN code in the DME menu. 

If you cannot find this option, it is because the DME administrator has disabled it. 

3 A screen with three fields is shown: 

 

Enter your regular password in the top field Password, a PIN code of your own 

choice in the middle field New PIN code, and repeat your PIN code in the bottom 

field Confirm new PIN code to make sure you entered it correctly. 

The DME administrator has set a minimum length of the PIN code (between 4 and 

10 letters and numbers). 
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4 Press Done to complete the PIN code definition. 

Now, when you want to log in, you have a choice of entering your regular password or 

your PIN code in the Login screen, where the Password field is now called 

Password/PIN code. 

 

The name of the password entry field in the Login screen will change back to 

Password when your PIN code expires. 

To reset your PIN code, enter your password in the Set PIN code screen, but leave the 

PIN code field blank. Selecting Done will then show a message that the PIN code has 

been disabled. 

 

On iPhone, you can furthermore set up a swipe code. For more 

information, see Swipe login in the iPhone Client User Guide. 

 
 

Synchronization overview 
The basic idea of the DME client is to keep the e-mail, calendar system, contacts, and 

possibly files of your mobile device up-to-date with the corresponding items on the 

corporate network. To do this, the DME client is synchronized with the collaboration 

system or the file server. E-mails, calendar items, and contacts are synchronized with 

the corporate collaboration system, and files are synchronized with files on the DME 

server or in a network location specified on the DME server. Please note that file 

synchronization requires a special license - consult your DME administrator for more 

information. 
 

What is synchronized 

In the synchronization (sync for short) process, DME checks the following: 

1 Have any items been created? An item could be an e-mail, a contact, a calendar 

item, a to do, or possibly a file. If an item has been created, it is copied to the 

system on which it does not yet exist (for example, if an e-mail was created and 

sent from the mobile device, the e-mail is copied to the Sent folder on the 

collaboration system).  

Furthermore, the e-mail, calendar and other items on the mobile device are 

synchronized with respect to the time span for which items should be shown 

according to the settings. This is called the synchronization window. For instance, 

the settings may specify that the e-mail application should show e-mails for the 

last 7 days. The sync process will then clear e-mails older than 7 days from the 

Inbox and other boxes except Drafts (on the mobile device only). 
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2 Have any items been deleted? If an item, for instance a meeting, has been deleted 

in the collaboration system, the deletion will be reflected on the mobile device. 

Note that e-mails deleted on the mobile device will not be deleted on the 

collaboration system, if the setting Delete only locally is enabled. Note also that 

you will not receive notification of changes when e-mails are deleted from the 

server. 

3 Have any items been edited? If you for instance edit a spreadsheet on the mobile 

device, the sync process will update the spreadsheet on the DME server if file 

sync. is enabled. In the same way, if you edit a contact on the mobile device or on 

the collaboration system, the change will be synchronized. 
 

Conflicts 

In some cases, a conflict may arise. For instance, if a meeting has been moved to 

another time on both the collaboration system and the mobile device, DME will 

resolve the conflict by moving the meeting to the time indicated in the DME client, 

and a message will be sent to you with information about this fact. 
 

Synchronization methods 

The DME client can be synchronized in four ways: 

1 Server-initiated sync (Push) 

Whenever someone sends you an e-mail, a meeting invitation, or similar, it is 

received by the collaboration system. The DME server constantly checks for such 

updates in the collaboration system, and sends a notification by network push or as 

an SMS (a text message) to the mobile device on which your DME client is 

installed. The notification is picked up, read, and (in the case of SMS push) 

deleted by the DME client, and a sync is initiated to make the device reflect the 

change in the collaboration system. The DME client will optionally notify you 

with a sound whenever a new e-mail has arrived in this way. Push sync is enabled 

and scheduled by the DME administrator. Notifications can also be sent in case 

system settings are updated or a server command is issued. 

Note that notifications may be disabled on the server, and that they may disabled if 

the device is roaming (see Roaming on page 19). 

2 Scheduled sync 

The client can be set up to synchronize at regular intervals. When synchronizing, 

all enabled resources are synchronized - that is, if the Sync. option for the resource 

in question (for instance To-do sync.) is enabled. The sync intervals are the same 

for all resources. 

3 Pull sync 

For e-mail and calendar items, you can set up a separate schedule for 

synchronization. This way you can for example set up scheduled sync intervals for 

contacts, to dos, and files, disable scheduled sync for e-mail and calendar, and 

enable pull sync for e-mail and calendar with a more frequent schedule. 

4 Manual sync 

Finally, it is possible to synchronize the client with the server manually by 

selecting a menu item in the client. You can synchronize the different resource 

types individually, or you can choose to sync all resources at the same time. 
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During the synchronization operation, the DME client shows a status messages about 

the current sync process in the interface. In order to optimize speed and bandwidth 

consumption, the DME server builds a list of commands to be executed by the client 

the next time it connects with the server. This is called a "command stack". When the 

client connects with the server, for instance in order to synchronize e-mail, the server 

will force the execution of those commands on the client. For this reason you may 

experience that, for instance, the e-mail sync you requested is followed by a calendar 

sync - meaning that the server takes the opportunity to update your calendar because a 

change has occurred. This command stack functionality can be disabled on the server. 

While the synchronization is in progress, you can cancel it by selecting Synchronize > 

Cancel sync. from the DME menu. 

 
 

Saving battery power 

Synchronizing with the server naturally requires battery power. In order to prevent 

your device battery from draining, and thus perhaps leaving you unable to place a 

phone call, DME turns off automatic synchronization when the battery level is low. 

When the battery level drops below 10%, DME turns off scheduled synchronization 

and push synchronization. Instead of synchronizing, the client writes an information 

message in its log file. 

Note that this applies to Symbian and Windows Mobile devices only. 
 

Other contact synchronization software 

When you use DME to synchronize contacts, it is important that you do not use any 

other software for the same purpose. 

On all platforms, there are software packages that offer to keep your contacts in sync 

with the collaboration system or other systems - for instance iTunes, Mobile Me, 

Microsoft ActiveSync, Nokia PC Suite/Ovi Suite, or similar. DME users are advised 

not to use these synchronization methods, as this may cause duplicate entries or 

corruption in your address book over time. 
 

Importing items 
The first time you log in to the DME client after installing it, you will be asked if you 

want to import e-mail from the server. When you accept to do this (recommended), 

your e-mails are imported from the DME server according to the default settings 

specified for the device on the server. 
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The first time you synchronize any resource, for instance calendar entries, the client 

will actually do an import.  When you choose to import a resource (either at first 

synchronization or later, see below), you will be asked if you want to keep the existing 

resources on the phone, or if you want to replace them from the server. (You will not 

be asked if there are no resources of that type on the device at all.) In most cases you 

want to choose Replace from server; you only want to keep the resource on the 

phone if you are sure that none of the items within the given resource exists on the 

server already.  

 

 

You can at any point choose to import items. In the DME menu, choose Tools > 

Import to see a list of resources that can be imported: 

 All items 

 E-mail 

 Calendar 

 Contacts 

 To-dos (not iPhone) 

 Files (not iPhone) 

The Import all function is a shortcut to importing all possible items according to your 

platform and client settings. 

Note that the DME administrator can also force an import of items on your device. In 

this case, you will not be asked if you want to keep the original entries; the device will 

simply start effecting the command and replace from server. 
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Synchronization vs. import 

There are two different ways of getting data from the collaboration system into the 

DME client. An import deletes any existing data on the device before bringing in data 

from the collaboration system. A synchronization checks for differences between the 

data on the device and data on the collaboration system, and then aligns the data – for 

example by retrieving new e-mails from the server, sending e-mails from the device, 

adjusting the time for a scheduled meeting, or bringing a contact on the server 

up-to-date with a contact which you have just modified on the device. 

Since e-mails cannot be changed, importing or synchronizing e-mails amounts to the 

same thing. However, if you should find duplicate e-mail entries in your mailbox, you 

can choose to import your e-mail from the server to realign the synchronization. 

Calendar entries, contacts, and to-dos are another matter. For these items, there is a 

risk that seemingly duplicate entries occur in your calendar or contacts if you 

synchronize, and you risk losing entries that have been entered on the device before 

you installed DME. There are at least three possibilities: 

1 The device is brand new: 

You can safely Import all items, as you have never added contacts or 

appointments on this device. 

2 You used to keep the device synchronized with the collaboration system using 

software such as Nokia PC Suite/Ovi Suite, Sony Ericsson Sync Station, Microsoft 

ActiveSync, or similar: 

You can assume that your contacts, calendar items and so on are up-to-date on the 

collaboration server. Therefore you should initially perform an Import of these 

items. Doing this clears data on the device and imports data from the server, 

ensuring that no duplicates occur. 

3 The device is not new, and has not previously been synchronized: 

Perform a synchronization of the device. This matches contacts on the device with 

your personal contacts on the server. DME checks for duplicates, but items are not 

recognized as duplicates if: 

a) Different data fields are completed for the contact on the device or the server. 

For instance, if "Home Phone" is completed on the device for the contact 

"John Doe", a "John Doe" on the server without a "Home Phone" will not be 

marked as a duplicate. 

b) The spelling is different in any completed field. 

c) When there is any doubt that an entry is a duplicate, a duplicate will be 

created. 

See also Flexible field mapping on page 18 below. 
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4 Clean up your personal address book and calendar on the collaboration system 

(using Outlook or Notes). This is an important step. You will probably find a 

number of apparent duplicates, but there will always be some difference as 

mentioned above. 

5 When you are satisfied with the information entered for your personal contacts in 

the collaboration system on the server, Import the contacts and calendar to the 

device. This will erase duplicates and bring in a fresh set of calendar items and 

contacts from the server. 

6 You can now add device specific features to the contacts, such as photos, speed 

dial keys, etc. These settings will not be lost when you synchronize contacts with 

the server (but they will if you import). 

If in doubt, please consult your DME administrator before importing or synchronizing 

these items the first time.  
 

Flexible field mapping 

It is possible to create custom mappings between fields in Domino or Exchange and 

contacts on the device. You can use this feature for enforcing company policies. 

For instance, you may have a policy of always calling the internal office number when 

calling a colleague in order to cut costs. You can then decide to add the internal office 

number to the "Pager" field in Notes, and map the Pager field to the "Telephone 

(business)" field on all devices. 

Custom mapping should be carefully planned, and can only be set up in cooperation 

with a certified DME partner. Partners may request special documentation from 

Excitor A/S. 
 

Preferred operators 
On the DME server, the administrator can define a number of preferred operators. 

First, one or more home operators is selected for your own country or area. Then, for 

each home operator, one or more operators can be selected for any country in the 

world. The selected operators should be those operators with whom the home operator 

has roaming agreements, and where the roaming prices are the best. 

If this system is in effect, your DME client will warn you about a change of network 

operators when you travel. For example: 

You are based in the United Kingdom. Your company has a special rates agreement 

with Vodafone in the UK and throughout Europe, so the DME administrator has 

selected Vodafone as your home operator and Vodafone as preferred operator in 

Germany. Now say you travel to Germany on business. Your phone is set up to 

automatically change to another roaming operator, so it automatically changes to 

T-Mobile. However, your DME client will show a message saying that in this country, 

your preferred operator is Vodafone, and you are encouraged to switch. 

 On Windows devices, the phone can switch to the correct operator for you. 

Up to three different, possible operators will be shown if multiple operators are 

selected on the server. 
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Roaming 

Apart from specifying preferred operators, the DME administrator can specify various 

cost-saving restrictions to the use of the device when a user is roaming. Whenever the 

user starts using a different mobile operator than the home operator, the following 

features may be restricted by the DME administrator: 

 Scheduled synchronization 

To save synchronization costs, the server may disallow scheduled sync when 

roaming. This means that the phone will not start synchronizing at the intervals 

specified in the Scheduled sync. settings, and the phone will not pull for e-mail or 

calendar items at the specified intervals (see Scheduled sync. settings on page 74, 

E-mail settings on page 70, and Calendar settings on page 72). 

 Manual synchronization 

To save synchronization costs, the server may also disallow manual sync when 

roaming. If manual sync is disabled when roaming, a message saying 

"Synchronization not allowed. Phone is roaming." will appear when you try to 

synchronize while using a roaming network. However, you will be able to 

synchronize manually once before the server discovers that you are roaming. 

 Network push 

To prevent keeping an HTTP connection open from the DME server on a roaming 

network, the server may disable network push when roaming. Instead, the server 

resorts to SMS push. 

When you return to your home operator's network, manual synchronization will again 

be allowed, regardless of any server restrictions. You must then perform a manual 

sync in order to let the server know that you are no longer roaming. 
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Symbian devices 

This section contains the specific guide for DME Client 3.5.5 for Symbian devices 

from Nokia and other vendors. 
 

User guide: Symbian devices 

DME supports a wide range of Symbian 3rd Edition, Symbian 5th Edition, and 

Symbian^3 devices. For a list of supported devices, please see the Supported Devices 

- Symbian 

http://www.excitor.com/Default.aspx?id=47&device_search=Symbian&device_sortb

y=product_group page at the Excitor website. 

The model used throughout this manual for illustration purposes is the Nokia E51, 

running Symbian 9.3: 

 
 

Installing DME on Symbian 

 

OMA DM installation 

Installing using DM requires that the device is bootstrapped. When the device is being 

bootstrapped, you must confirm a DM Service Message by entering a PIN code: 

12345. Then choose Save in the Options menu. After this, the installation and 

subsequent upgrades of DME through OMA DM is completely transparent. The DME 

client will appear on the device, prompting for login information. 

Push installation 

When the DME Administrator has "pushed" DME to your phone (as opposed to 

installing using OMA DM), you will receive an SMS or a WAP Service Message with 

the text DME Software Installation and a link. 

1 Open the message. 

 

http://www.excitor.com/Default.aspx?id=47&device_search=Symbian&device_sortby=product_group
http://www.excitor.com/Default.aspx?id=47&device_search=Symbian&device_sortby=product_group
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2 Click the highlighted link (WAP Service Message), or 

Scroll to the link (SMS), click, and choose Open link. 

3 A web browser opens, and you are prompted to download the DME installer (you 

may have to accept a browser security warning first). 

 

When the DME installation program has been downloaded, the installation proceeds 

automatically. To install DME (see also pictures below): 

1 Select Yes to install DME. 

2 Details about the DME program are shown. Select Continue. 

3 If this is the first time DME was ever installed on this phone, you may be asked to 

accept the installation of a certificate, if your company uses the DME self-signed 

certificate. Select Continue. 

4 Select OK to accept the DME license agreement. 

5 Wait for the installation to complete. 

6 Select Yes to start DME. 

  

  

You may observe a second SMS from the DME server in your Messaging Inbox - this 

is the server path, which is sent to the device immediately after the SMS or Service 

Message containing the download link. The server path message is deleted by DME as 

soon as you log in for the first time. 
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Starting the DME client 
The DME client will usually be set up to launch automatically when you start the 

device. DME contains a number of security features that depend on the client being 

started. Furthermore, the client contains a feature that makes it impossible to shut 

down the client without also shutting down the device. For more information, see 

Data security on page 9. 

If the DME client does not start automatically, do the following to start it. 

 Starting the DME client 

1 From the Menu screen, open the folder where user-installed programs are located 

(typically called the Installations folder, the Installat. folder, or the Applications 

folder). 

2 Open DME. 

 

You might find it easier to assign DME to a shortcut key on your device. Look for 

"Active standby" in your device manual for more information. 

 Switching to DME if the client is already running 

1 Press and hold the menu key. 

2 Select the DME application using the navigation key. 

 

You can also launch DME by responding to an e-mail notification. See Notifications. 
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Logging in 

When the DME client is launched, the login window is shown: 

 

You must log in with the same user name and password that you would use for the 

collaboration system on your desktop PC. For Lotus Domino users, this is your 

"Internet password". Contact your IT department if you have problems with your user 

name or password. 

If the DME client was already running, and you are logging in again after logging out 

(either manually or automatically after a period of inactivity), the screen shows the 

time of the last synchronization with the collaboration system and the number of new 

e-mails. 

The client remembers the user name from your last login, unless the DME 

administrator has disabled this feature for security reasons. 

 

If you have defined a PIN code, you may log in using that rather than your LDAP 

password. See Logging in using a PIN code on page 11. 
 

First-time login 

If you are logging in to the client for the first time, the login process is different. When 

you start the client, the login screen is shown, but without the indication of last 

connection and number of new e-mails. 
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 Logging in to DME for the first time 

1 Server path: If the installation file was pushed to your device from the server, the 

server path is sent to the device along with the installation file, in a separate SMS. 

When DME launches, the server path is read from that SMS. 

If DME was installed through OMA DM, the server path is included in the 

installation instructions, and you need not supply the path.  

If DME was installed in another way, for instance through cable transfer, you must 

enter the server path here. The server path has the form 

https://dme.yourcompany.com:5011, where dme.yourcompany.com is 

the name of the server where DME is installed, and :5011 is the port number. 

In case you lose the path to the server, contact the DME administrator. He or she 

can send the server path to your device using the Send server path function in the 

Devices tab in the Web Administration Interface. Alternatively, you can enter the 

following in the Username field: SERVERPATH, and then press Login. This lets 

you specify the Internet address of the DME server. Press OK, restart DME, and 

confirm the new path: 

 

2 Login: Enter your user name and password, and select Login. Lotus Notes users 

should note that this is your "Internet password" (the same as for your webmail).  

Since this is the first time you enter your user credentials, DME needs to make a 

connection to the server to verify that your user name and password match, so the 

first-time login takes a little longer than subsequent logins. DME stores your 

password in multi-hashed, encrypted form (that is, very secure) on the client. 

Therefore, the next time you log in to the client, you do not need to make a server 

connection to verify your login. However, when you do make a connection (for 

instance when you synchronize e-mail), your login credentials will be verified 

again. 

3 Access points: The access point defines how data traffic is sent from the device. 

The DME installer tries to set up three possible access points automatically (since 

client 3.0.2 and above). The installation process evaluates any existing internet 

access points (IAP) on the DME client, and places three access points in the 

General settings page on the device. The IAPs are selected and placed based on 

their perceived cost, according to the following scheme:  

 WLAN IAPs are selected first. A maximum of 2 WLAN IAPs are selected and 

placed as preferred access points 1 and 2.  

 For the remaining access point (or points, if less than two WLAN access 

points were found), the installation process finds one or more IAPs where the 

name contains the word "internet" or "www", and uses it or them as 

subsequent access points.  

 If no such IAP is found, then the first available IAP is used for the remaining 

access points.  
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With this scheme, the IAP incurring the lowest cost is probably picked first, 

namely the corporate WLAN, and then possibly the user's home WLAN is picked 

next. The third access point is then the general GPRS IAP. 

However, the administrator can choose to name a GPRS and/or WLAN access 

point as "DME_AP_(something)". If this access point is pushed to the phone along 

with the installation command, it will be installed as first choice. If more than one 

access point starts with "DME_AP", they will be selected in random order as first, 

second, and third access point. 

You can change the selections later from within the DME client. 

4 Import: If the login process is successful (that is, DME can establish a connection 

to the DME server and log in using your user name and password), you are 

prompted whether you want to import your e-mail at this point. This is a good idea 

after your first login. See Importing items on page 15 for more information. 

You are now ready to use the DME client. 
 

Removing the client 
Uninstalling the client from a device follows the usual procedures for each platform. 

The DME administrator may have specified on the server that you are never allowed 

to uninstall the client. In this case, you are unable to do so. 

Alternatively, the DME administrator may specify that you are only permitted to 

uninstall the client if you are logged in. In this case, you will be prompted for a user 

name and password when you attempt to uninstall the client. If you enter the correct 

credentials within one minute, you will be permitted to continue uninstalling the 

client. 

 Uninstalling the DME client for Symbian 

1 Open the menu by pressing the Menu key. 

2 Select Control Panel > App. Mgr. > Installed apps., or go to the folder where 

your programs are installed (for example Installations, Installat. or 

Applications). 

This step varies from device to device; for more information, see the manual for 

your device. 

3 Highlight DME. 

4 Select Options > Uninstall or Remove. 

5 Press Yes to continue. 

  

The DME client and associated data – e-mails, calendar entries, contacts, and 

synchronized files – are removed from the phone. 
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Using the DME client 

The main DME screen is the Desktop. The Desktop gives you quick access to the most 

commonly used features in DME. 

 

Use the navigation keys to move to the different icons. Moving past the last icon on 

the screen moves focus back to the top. Click the center navigation key to run the 

function associated with the icon. 
 

Desktop actions 
The following is a brief explanation of each Desktop icon, with references to more 

information: 

 
Go to the Inbox (see Navigating the folder tree on page 29) 

 
Go to the Unread folder (see Navigating the folder tree on page 29) 

 
Open the Folders screen (see Navigating the folder tree on page 29) 

 
Create a new e-mail (see Creating and sending e-mails on page 39) 

 
Open the internal DME Calendar (see Calendar on page 52) 

 
Create a new meeting invitation (see Booking meetings on page 59) 

 
Synchronize e-mail (see Synchronization overview on page 13) 

 
Open the Search menu (see Search on page 47) 

 
Open the Settings page (see Settings on page 66) 

 
Go to the Contacts application (see Contacts on page 63) (not Java 

devices) 

 
(Symbian devices only) Open the SmartEncrypt on-the-fly encryption 

application (see the SmartEncrypt Quick Guide) 

 
(Some Nokia S60 devices only) Open the VoiceExtender™ call 

answering machine (see the VoiceExtender™ Quick Guide) 
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Apart from these icons, you can use the DME menu (Options) to access all functions 

in DME. You can access the DME menu from all views in DME. For an overview of 

the DME menu, see Menu tree on page 76. 

For information about how to configure your Desktop, see Desktop settings on page 

76. 
 

Shortcuts 
To quickly access the most common features in DME, you can press a keyboard 

shortcut. Press * followed by one of the keys 0-9 to access the shortcut actions. Note 

that with some devices with full keyboards you must use a modifier key before the *. 
By default, the following shortcuts have been defined: 

Press... ...to execute the following action 

*0 <Not defined by default> 

*1 Synchronize e-mail 

*2 Mark as read 

*3 Mark as unread 

*4 Create a new e-mail 

*5 View folders 

*6 Open the DME calendar 

*7 Create a new meeting 

*8 <Not defined by default> 

*9 Open the Contacts application 

If you cannot remember a shortcut, press ** (the star key twice) to display a help 

screen, listing the currently defined shortcuts. 

Shortcuts can be used whenever the cursor is not inside an editable field (in an 

editable field, the shortcut keys will simply be inserted as regular characters). 

You can change the definition of shortcuts to better suit the way you use DME. For 

more information, see Shortcuts settings on page 75. 
 

Working with folders 
The DME mailbox consists of at least the following folders: Inbox, Outbox, Drafts, 

Sent, and Unread. The first four of these folders function as the corresponding folders 

on the collaboration system (Notes or Outlook). The Unread folder is a smart folder 

which shows all unread messages in any folder in the DME client. When an e-mail in 

the Unread folder is read, it disappears from view - but naturally remains in the folder 

from which it originated. 
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Apart from these standard folders, subfolders created on the collaboration system 

(Notes or Outlook) can be shown on the client. Subfolders from the collaboration 

system can be shown if the folder synchronization feature is enabled on the DME 

server and on the client (see Folders settings on page 72). If enabled, you have access 

to all the e-mail folders on your collaboration system. With settings similar to the 

e-mail settings (see E-mail settings on page 70) you can specify how many e-mails 

you want to see in each folder (by age in days) and whether you want to synchronize 

e-mails in folders at all. This is specified as a system-wide setting. In the following 

section you can see how to specify different settings for each folder, including whether 

you want to receive a notification when a new e-mail arrives in a folder. 
 

Navigating the folder tree 

To move between folders, click the desktop Folder icon , or select View > 

Folders in the DME menu (or press *5). When you do this, DME shows a list of all 

folders in the system. You can then move to the desired folder, and click to open the 

folder in mailbox view. 

Notice the following in the folder selection screen: 

 

1 To navigate to the subfolders, press the scroll key to the right; to see any e-mails 

in the folder, press the center navigation key. 

2 When a mailbox folder includes other folders (subfolders), it looks like this: . 

The names of the subfolders are listed below the name of the parent folder. Also, a 

right-arrow is shown in the top bar. 

3 If the plus sign on a folder is grey like this:  it means that it cannot be selected. 

On Domino systems, you can create folders and subfolders at the same time by 

naming a new folder like this: Work\Testing. When created in this way, the parent 

folder (Work) cannot itself contain e-mails (but Testing can). Therefore you cannot 

select the parent folder here, but you can navigate to the subfolder by pressing the 

scroll key to the right. 

This is what the DME folder from the illustration above looks like. 

 

A left-arrow in the top bar indicates that you must press the scroll key to the left in 

order to display the parent folder again. Also note the ..\ in front of the folder name in 

the top bar, which indicates that you have moved one level down in the folder 

structure. 

Folders that you have chosen to keep synchronized (see the next section) are shown 

with a synchronization symbol: . 

Press Close to return to the folder from which you opened the Folder view. 
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Setting folder options 

You can set defaults for the way e-mail folders should be synchronized between 

collaboration system and client (see Folders settings on page 72). If you have many 

folders on the collaboration system, it is recommended that you set up very restrictive 

default settings for performance reasons, and loosen up on individual folders as 

described below. 

To change synchronization options for a folder, open the folder view described in the 

previous section, browse to the folder you want to customize, and select Settings in 

the DME menu. The following screen is shown: 

 

 Use default values 

If this field is set to Yes, the current folder uses the general settings specified (see 

Folders settings on page 72). If Apply to subfolders is also selected, the default 

settings will be applied to all subfolders below the current folder as well, when 

you press Done. If the value in this field was No, and you change it to Yes, the 

settings in the remaining fields in this screen will be reset to the default values 

when you press Done. 

If you want to apply other settings than the default settings to this folder, you must 

select No in this field. 

 Sync. folder 

This option can only be changed if Use default values above is set to No. If this 

field is set to Enabled, e-mails in the current folder are synchronized with the 

collaboration system, using the synchronization window defined in the field Days 

back below. To avoid too high load on the DME server, you should only 

synchronize those e-mail folders that you really need on the device. You can for 

example consider to not synchronize folders containing graphics-intensive 

newsletters etc. Synchronized folders are shown with an icon like this: . 

 Include in mail scan 

This option can only be changed if Use default values above is set to No. If this 

field is set to Enabled, you will receive notification when a new e-mail arrives in 

the current folder. New e-mail can "arrive in" subfolders by means of rules, which 

are set up on the collaboration system to automatically distribute new e-mails in 

folders. 

 Days back 

This option can only be changed if Use default values above is set to No. When 

e-mails are synchronized, e-mails from the last number of days selected here will 

be synchronized and available in the current folder. 
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 Apply to subfolders 

If this field is set to Yes, the settings made in other fields in this screen are 

propagated to folders below the current folder when you press Done. Use this 

function with caution, as the setting may affect many folders. Note that you can 

choose this option regardless of the value of the field Use default values above. 

Instead of synchronizing e-mail to the client, you can use the Search e-mail (on 

server) function to find e-mails in any folder on the collaboration system. See E-mails 

(on server) on page 49 for more information. 
 

Symbian touch devices 
Excitor provides a separate client for Symbian touch devices (5th Edition and 

Symbian ^3 phones), for instance Nokia N97, Samsung i8910 Omnia HD, and Sony 

Ericsson Satio (the Idou). 

The basic functionality of the DME client for Symbian touch devices is the same as 

for the client for 3rd Edition devices, which is described in this manual. However, 

some differences exist, due in part to the large touch screen and in part to the different 

input method of he touch devices. 

Below is an illustration of the Inbox on a Nokia N97 device. 

 

The most important differences exist when the keyboard is closed, and are listed 

below. It is important to know these differences in order to work smartly with DME. 
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 To scroll up and focus on the first field in a new e-mail or meeting: 

Tap the information area (the top part of the screen). Note that this is the only way 

to go from the body field in an e-mail to the recipient fields (unless you open the 

keyboard). 

 

 To add a description to a meeting: 

With the phone in landscape mode, the only way to go to the Description field 

(without using the keyboard arrows) is to tap the area above the Description field, 

to the right of the Alarm and Private check boxes. To view the other fields again, 

tap the area next to the DME logo (as in illustration above). 

 

Note: Symbian^3 devices do not have the buttons shown above. 

 To scroll up and focus on the first e-mail in a folder: 

Click the information area (the top part of the screen). 

 To use the type-ahead feature (quick recipient entry) in a new e-mail or 

meeting:  

Tap the person icon to the left of the recipient input field. (Other methods are 

possible too, depending on text input method.) 

 To expand the body text area to full screen when writing a new e-mail: 

Tap the body field of the new e-mail. Tap the information field to see the recipient 

and subject fields again. 

 To select multiple e-mails in a folder: 

Tap the area around the e-mail icon. 

 To scroll page by page in a folder: 

Flick through the list, or tap the top or bottom parts of the scroll bar area. 
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The DME client for Symbian touch devices does not yet support the drag and swipe 

gestures. 
 

E-mail 

Click the  icon from the Desktop (DME menu: View > Folders > Inbox) to open 

the Inbox, which displays the e-mails and meeting invitations that have been 

synchronized to the client. 

Press the scroll key right and left to cycle between the different mailbox folders: Inbox 

– Outbox – Drafts – Sent – Unread. Press the scroll key up and down to scroll through 

any items in each folder. 

If folder synchronization is enabled on the server, you can access all your mailbox 

folders by selecting View > Folders in the DME menu (see Working with folders on 

page 28). 

Above the e-mail list you can see the total number of e-mails in the current folder. In 

the Inbox, the number of unread e-mails is shown in parentheses. The number of 

unsent e-mails in the Outbox (if any) is shown to the right in all the other mailbox 

folders after the Outbox symbol . 

If your company uses the IBM Sametime instant messaging (IM) application, you can 

choose to view the Sametime status of your Sametime contacts in the mailbox folders 

(see General settings on page 66). If you do this, a symbol next to the name of the 

sender of an e-mail in a mailbox indicates his or her Sametime status: Away , In a 
meeting , Do not disturb , or Available . 

The illustration below shows the main DME mailbox interface. 

 

Use the scroll key to navigate through the user interface. 
 

E-mail icons 
On the left side of of each e-mail in the mailbox view, an e-mail icon is displayed. The 

icon tells you quite a bit about the e-mail at a glance: 

 An unread e-mail is shown as an unopened envelope. The sender is displayed in 

a boldface font. 

 An already read e-mail is shown as an opened envelope. 

In addition to this, different symbols can be superimposed on the e-mail envelope, 

providing you with more information: 

Symbol Meaning 

 
This e-mail contains one or more attachments. 
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This e-mail is a meeting invitation. 

 
This e-mail has high priority. 

 
This e-mail is encrypted. 

 
This e-mail is signed. 

 An e-mail in the Drafts folder. 

 An e-mail in the Sent folder. The e-mail icon in both the Drafts and the Sent 
folders can be superimposed by the attachment, priority, encryption, or signature 

symbols. 
 

Reading e-mails 
To open an e-mail, select the e-mail in a folder, and press the scroll key. 

Scroll through the e-mail body by pressing the scroll key up or down. By pressing the 

[*] key you toggle between line or page scroll. In page scroll mode, the symbol  is 

displayed in the top bar, and the cursor acts according to the table below: 

Scroll key Normal scroll mode Page scroll mode 

Scrolling up/down One line at a time One screen at a time 

Scrolling left/right One character at a time One word at a time 

 
 

Links 

When scrolling through an e-mail, the DME client will search for different links such 

as e-mail addresses, phone numbers, and web links. Whenever a link is found, it is 

highlighted. You can activate options for the link by pressing the scroll key on the 

link. 

For e-mail addresses and phone numbers, you can select Call or Add to contacts. 

 If the highlighted text is a phone number, you can dial the number using the Call 

option (or simply pressing the green Call key ). If the text is an e-mail address, 

the Call option will scan your local contacts for contacts with the e-mail address in 

question and present the phone number(s) of the found contact, allowing you to 

make a call to the contact. Press OK to call the selected phone number. For more 

information, see Calling the sender on page 38. 

 The Add to contacts option will copy the highlighted text to the clipboard, and 

open your Local contacts. 

In your Local contacts application, press Options to choose among the following 

options: Edit contact, New contact, or Refresh contacts. 

 Edit contact will open the selected (highlighted) contact. 

Now you can scroll down the list of information. When the field type fits the 

contents of the clipboard, an Add here command will appear as an option. In this 

way you can add an e-mail address to a contact. 
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 New contact functions in the same way as Edit contact, with the exception that a 

new, empty contact is created first, allowing you to enter a name for the contact. 

 Refresh contacts reloads your contacts and is normally used when changes have 

been made to your contacts' information. The reason that the DME client does not 

update the contacts automatically is that this can be a time-consuming procedure. 

When a web address is selected, you can open the link in a browser by the pressing the 

scroll key and selecting Yes. 
 

SmartLinks 

SmartLinks are links in the body text of e-mails, which are handled in a special way 

by the DME client and the DME server. SmartLinks may for instance link to Word 

documents, PDF files, or other binary files that are only available on, say, the 

corporate intranet. Such files are not usually available from outside the corporate 

network (without using a VPN connection). However, when you select the SmartLink, 

the DME client is able to download the file as if it were an attachment in the e-mail. 

The use of SmartLinks requires the DME administrator to set up the DME server in 

such a way that the DME client recognizes certain links in the mail body text as 

special links. As described in the previous section, DME automatically highlights web 

links - that is, links starting with http: or https: or www. If any such link contains the 

text defined on the DME server, the link will be treated in a special way - instead of 

opening a browser window, the client will send a request to the DME server, which 

will then prompt the client to log in and download the requested file (if it exists). You 

can say that the server acts as a proxy. 

 

 

Example: the body text of an e-mail contains two links: 

1 http://www.example.com/onepagedown 

Selecting this link will open the built-in browser and go the onepagedown page at 

www.example.com. This is a normal web link. 

2 http://intranet.example.com/doc?id=234 

Provided that http://intranet.example.com has been defined as a SmartLink site on 

the DME server, selecting this link issues a request to the DME server to 

download the document defined by the document ID 234. 

The downloaded file is opened by the associated viewer immediately. When you close 

the viewer, the file is deleted from the device. 

Please note that the SmartLink functionality is an add-on to DME, and special 

documentation concerning how to set up this feature is available. 
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Attachments 

When you receive an e-mail with an attachment, you will see an attachment icon in the 

mailbox . 

Graphics that have been embedded into an e-mail may be shown as attachments on the 

client. This requires DME server version 2.0 and above and that you run Domino as 

your collaboration system. 

 Opening an attachment 

1 Open the e-mail. 

2 Select Attachments in the DME menu. 

A list of the attachments to the e-mail is displayed. 

 

3 Select the attachment. 

4 Select Yes to download and open the attachment. 

DME connects to the server. 

5 Select Yes to allow the attachment to be decrypted to disk. 

The attachment file is stored in a temporary folder on the device disk, which is 

outside the secure DME area. It is deleted from the temporary folder again when 

you log out of DME. If DME cannot delete the attachment immediately when you 

log out, for instance if it is still open in the application, it will keep trying at 

regular intervals. 

To save transmission time and space on the device, attachments are not stored on the 

device unless you specifically choose to download them. In the attachment list, the  

icon shows if the attachment is only located on the mail system server. A 

phone-and-clip icon  means that the attachment has been downloaded to the device. 

The device supports several types of attachments depending on the programs installed. 

By default, the device will recognize several types of image files such as .bmp and 

.jpeg, sound files such as .wav, and text files. Usually the device will also be able to 

open Microsoft Office and Adobe PDF files. Please refer to the user manual of the 

device for further information.  

If the file does not have a file type association, an error message will be displayed, and 

the file will not be downloaded. If you have a program that you know will open the 

file of the type in question, you must set up a file association to that file type, and try 

to download the attachment again. For information about file associations, see your 

mobile phone documentation or the documentation for your mobile phone operating 

system. 

Apart from opening the attachment, you can 
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 Send the attachment via Bluetooth or other medium supported by your device (see 

Sending an attachment on page 37) 

 Delete the attachment from the temporary folder on the device (see Removing 

attachments on page 37) 

Note that the DME administrator may have disallowed the download of attachments 

for security reasons. 
 

Sending an attachment 

When an attachment has been downloaded to the device, you can use the device to 

send the attachment to an external source. 

 Sending an attachment (not by DME secure e-mail) 

1 Open the e-mail that contains the attachment. 

2 Open the DME menu, and select Attachments. 

3 Select the attachment. 

4 If the attachment has not been downloaded to the device (indicated by an ), you 

must choose to open the attachment first. 

5 Open the DME menu, and select Send with... 

6 Select the method by which you want to send the attachment (see below). 

Sometimes only one option is available, for instance Bluetooth, and the device will 

start the detection or transfer immediately. 

Note that this feature may have been disabled by the DME administrator. 

Follow the instructions from the device manual on how use the specified send method. 

Send method Description 

Via message Creates a multimedia message (MMS) with the selected 

attachment. 

Via e-mail Creates an e-mail with the selected attachment using the 

built-in, usually POP3-based, e-mail program. 

Via Bluetooth Sends the selected attachment via a Bluetooth connection to 

another device or computer. 

Via infrared Sends the selected attachment via an infrared connection to 

another device or computer. 

Upload Upload to file sharing site, such as Ovi, Flickr, or Vox. 

 
 

Removing attachments 

When you download attachments to the device, the attachments will take up space on 

the device. To free this space, you have the option to remove downloaded files from 

the device. The attachments will not be deleted on the mail system, only on the DME 

client. 
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 Removing a single attachment 

1 Open the e-mail containing the attachment. 

2 Open the DME menu, and select Attachments. 

3 Highlight the attachment. 

4 Open the DME menu, and select Remove from phone (or press the Delete key on 

your device). This option is only shown if the attachment has in fact been 

downloaded to the device (indicated by ). 

5 Press Yes to confirm. 

 Removing all attachments from the device 

1 Go to the mailbox view of any folder. 

2 Open the DME menu, and select Actions > Delete all attachments. 

3 Press Yes to confirm. 
 

Viewing e-mail details 

You can see a summary of information about the e-mail you are reading. 

 Viewing e-mail details 

1 Open an e-mail. 

2 Open the DME menu, and select E-mail details. 

An information box shows information about the current e-mail. 

The information consists of a list of recipients of the e-mail (individual recipients or a 

mail group), importance level (if high), and the date and time the e-mail was received. 

Press OK to exit the information box. 
 

Calling the sender 

You sometimes find yourself needing to call a person from whom you have received 

an e-mail. In DME, you can use the green call key  to place a call to the owner 

associated with any selected e-mail address. 

 Calling a number associated with an e-mail 

 In any mailbox folder, you can scroll to an e-mail from (or to, in the case of the 

Sent folder) the person whom you want to call. Press the green call key. 

 If you are reading an e-mail, you can move to the sender field and press the green 

call key. 

or 

 If an e-mail address in the e-mail is highlighted as a link (see Links). 

In all cases, DME searches your local address book for a contact with the specified 

e-mail address. The outcome of this search can vary, and DME will act according to 

the result in the following ways: 

 The selected e-mail address is found in your local address book: 

The phone will dial the number of the associated contact. 
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 The selected e-mail address is found in your local address book, but more 

than one phone number is associated with the contact: 

DME shows a list of the associated numbers. Scroll to select one number, which is 

then dialed. Note that a default number may have been specified by the DME 

administrator. The administrator can for instance specify that the number stored in 

the Fax (business) field of your contact should be the default number, because 

company policy specifies that a cost-saving short number should be stored in that 

field. The default number will be pre-selected in the list of numbers shown. 

On devices that support a default number feature in their local Contacts (most 

Symbian devices do), the administrator-enforced default number will be set as 

default on all contacts. This means that phoning a contact from the native 

phonebook application will dial the Fax (business) number immediately (to 

continue with the previous example). 

 Multiple contacts in the local address book are registered with the selected 

e-mail address: 

DME shows a list of the names of the contacts having the e-mail address in 

question. Scroll to select a name, which is then dialed immediately if only one 

number is registered for that contact; otherwise a list of the phone numbers of the 

contact in question is shown. 

 The selected e-mail address is not found in your local address book: 

DME asks for permission to search the the Global Address Book. If you accept 

this, the search screen is opened, and the selected e-mail address is inserted in the 

E-mail field. You can now search for the e-mail address in the Global Address 

Book. When you receive the search result, press the green call button on any of the 

found persons to place a call to that person. The default number feature (see 

above) applies to Global Address Book searches as well. See Global Address 

Book on page 47. 
 

Other e-mail options 

Apart from the options concerning attachments, e-mail details, and calling the sender 

mentioned above, you can open the DME menu for more options: 

 Reply / Reply to All 

Create a reply to the e-mail - see Replying to e-mails on page 43. 

 Forward 

You can forward the e-mail - see Forwarding e-mails on page 43. 

 Move to folder 

If folder synchronization is enabled, you can use this option to open the folder 

selection view (see Navigating the folder tree on page 29). Pick a folder, and 

select to move the current e-mail to the folder in question. 

 Delete 

Delete the current e-mail. You can do this by pressing the Delete button as well. 
 

Creating and sending e-mails 
 Creating and sending an e-mail 

1 Select Create > E-mail from the DME menu almost anywhere in the DME client. 

or 

Click the New e-mail icon in the Desktop:  



40 

 

DME Client User Guide 3.5.5 : ©2011 Excitor A/S 

 

2 Enter message details as described in the next section - see E-mail details on page 

40. 

3 In the DME menu, select Send. 

The e-mail is now saved in the Outbox. Depending on the e-mail settings, the e-mail is 

sent immediately or queued for the next scheduled or manual synchronization (see  

E-mail settings on page 70). When the e-mail has been sent, it is moved to the Sent 
folder. 

Note that you can also create an e-mail by finding one or more e-mail addresses 

through the Global Address Book first, and then choosing to create an e-mail using the 

selected e-mail addresses. For more information, see Global Address Book on page 

47. 
 

E-mail details 

The e-mail form works like a normal e-mail with fields for Send to, Carbon Copy (CC), 
Blind Carbon Copy (BCC), Subject, and Body. If you need to type multiple recipients in 

a field, you can separate the recipients using a comma (Lotus Notes style) or a 

semicolon (Outlook style). 

Tip: Some collaboration systems are able to resolve names of known users. This 

means that you only have to enter the short name as the e-mail recipient. For instance, 

you could just enter sad in the Send to field, and the collaboration system would 

resolve (expand) the name to Sabine.Adelhof@excitor.com automatically. Ask your 

DME administrator if this is possible in your setup. 

Tip: For devices without a full keyboard, you can insert a new line in the e-mail body 

by pressing the center or right scroll key (depending on device model). 
 

Entering recipients 

With the cursor placed in the Send to ( ), CC ( ), or BCC ( ) field, you can start 

typing the name of a recipient. DME will try to predict who you want to enter as a 

recipient, and shows suggestions in a drop-down list below the recipient field: 

 

As you use DME, DME builds a history database of e-mail recipients. This database 

consists of the 200 most recently used e-mail addresses, gleaned from your Inbox and 

Sent mailboxes, from participants in meetings where you are a participant or chair, 

and from your local contacts. DME uses this information for generating the 

drop-down list dynamically, according to the following principles: 
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 If you press the scroll key in the field without typing anything, a list of the five 

most recently used recipients is displayed, along with a link to the local contacts 

and the Global Address Book. 

 If you start typing, DME will match the typed characters with the names and 

e-mail addresses in the history database. For instance, typing a "c" will match the 

following entries in the database: 

 "Chris Rea <chris.rea@music.com>" 

 "Hooray Carlton <hooray@freude.de>" 

 "Melanie C. <melc@spice.com>" 

-but not "Martin Olsson <mols@corp.com>" even though both corp and com 

begin with a c - only the name part of e-mail addresses is searched, not the domain 

part. 

Links to the local contacts and the Global Address Book are also shown. 

As you type more characters, the list will grow shorter. In the example above, typing 

an "a" after the initial "c" will limit the list to "Hooray Carlton <hooray@freude.de>" 

only.  

Use the scroll key to move down the list. As you highlight the different choices, the 

highlighted name and e-mail address will scroll sideways to let you see the full length 

of the text, if it is too long to be shown in the list. 

When displaying search results in the list, DME ranks them in the following order: 

1 E-mail addresses found among the most recently sent items. 

2 E-mail addresses found among the most recently received items. 

3 E-mail addresses found among the local contacts. 

With regard to the local contacts, please note that DME adds contacts to the history 

database during the synchronization process. This means that if you add a contact on 

your phone, it will not appear in the list until after you have synchronized contacts 

with the server. 

Press the scroll key to insert the currently highlighted e-mail address in the recipient 

field. DME inserts a comma after the recipient, so you can immediately press the 

scroll key or start typing to insert another recipient. Press the right navigation key to 

close the list without selecting anything. 

Pressing Local contacts or Global Address Book lets you search the local or global 

address book, respectively. If you have entered any characters in the recipient field, 

they are transferred to the search field. For more information, see Address book 

integration see "Entering recipients" on page 40, on page 41 below. 
 

Address book integration 

If the cursor is placed in the Send to ( ), CC ( ), or BCC ( ) field, you can search 

for contacts in the Local contacts or the Global Address Book by pressing the 

navigation key or by beginning to type as described above. 

Local contacts are contacts stored on your device. This usually corresponds to your 

Personal Address Book on the collaboration system. Only contacts with associated 

e-mail addresses are shown. Scroll and click to select the contact(s) you wish to send 

the e-mail to, and select Done from the DME menu. 

Apart from Done, the DME menu in your Local contacts contains the following 

options: 
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 Select/Unselect corresponds to pressing the scroll key. 

 Details opens a small window with more information about the current contact, 

including any alternative e-mail addresses and phone numbers. 

 Refresh contacts reloads your contacts and is normally used when changes have 

been made locally to your contacts' information. The reason that the DME client 

does not update the contacts automatically is that this can be a time-consuming 

procedure. 

 Call dials the phone number associated with the currently highlighted contact. 

You can also press the green call key . If more than one number is associated 

with the contact, DME lets you choose from a list of the available numbers. 

The Global Address Book is the shared address book on the collaboration system. If 

you select this option, you can search for a contact by Name, E-mail address, 

Department, Country, and Title. For more information about how to select recipients 

using the global address book, see the procedure in Global Address Book on page 47. 

When you have selected the desired recipients, open the DME menu and select Done. 

The e-mail address of the contact(s) will be added to the field from which you started 

selecting recipients. If any of the recipients have multiple e-mail addresses, you will 

be able to choose between the addresses of each recipient. 
 

Saving as draft 

If you want to continue editing an e-mail at a later time, you can save the e-mail as a 

draft. 

 Saving an e-mail as a draft 

1 Open the DME menu, and select Save as draft. 

or 

2 Close the e-mail, and select Save as draft when asked. 

The e-mail is saved to the Drafts folder, and you are returned to the mailbox. When 

you want to finish the e-mail, you can open it from the Drafts folder, edit it, and send it 

in the usual way. 
 

Selecting message options 

You can sign, encrypt and mark the message with high importance. 

 Setting message options 

1 Open the DME menu in the e-mail you are creating, and select Message options. 

2 Scroll up/down to select an option. 

3 Press the scroll key to enable or disable the selected option. 

4 Select Done to return to the e-mail. 

Please note the following about signed and encrypted e-mail:  
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 When you send a signed e-mail, and the DME server cannot find your private key 

on the server, an e-mail with a notification of the error "The DME Server could 

not send the signed S/MIME e-mail") is sent to you by the DME server. Your 

e-mail will be sent to the recipient; however, it will not be signed. 

 When you send an encrypted e-mail, the DME server needs to know the public 

key of each of the recipients of the e-mail. If the public key of one of the recipients 

is unknown to the server, an e-mail with a notification of the error ("Cannot find 

certificate for recipient: xx") is sent to you by the DME server. The e-mail will not 

be sent to any of the recipients. 

Using signed and encrypted e-mail requires special setup. Please contact your DME 

administrator. 
 

Replying to e-mails 

When replying to an e-mail, you have the option to reply to the sender with or without 

history (that is, with the original e-mail appended to the e-mail), or reply to all with or 

without history. 

 Replying to an e-mail 

1 Open the e-mail you want to reply to. 

2 Open the DME menu, and select Reply or Reply to All. 

3 Select With history or Without history. 

4 If the original e-mail contained attachments: 

Press Yes to include attachments, or 

Press No to send the e-mail without attachments 

See Sending attachments on page 44 for information about how to work with 

attachments in e-mail replies. 

A new e-mail is created for the original sender and possibly all original recipients. 

You can now add text and attachments, and select Send to send the e-mail. 

If the e-mail you are replying to was signed, encrypted, or marked with high priority, 

DME will copy these settings to the new e-mail. 
 

Forwarding e-mails 

You can forward an e-mail with all content, including attachments. 

 Forwarding an e-mail 

1 From any folder, open the e-mail. 

2 Open the DME menu, and select Forward. 

3 If the original e-mail contained attachments: 

Press Yes to include attachments, or 

Press No to send the e-mail without attachments 

See Sending attachments on page 44 for information about how to work with 

attachments in forwarded e-mails. 

You can now add recipients, text and attachments, and select Send to send the e-mail. 

For information about how to enter recipients, see Entering recipients on page 40. 

If the e-mail you are forwarding was marked with high priority, DME will copy this 

setting to the new e-mail. 
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Sending attachments 

You can include attachments in e-mails in two different ways: by forwarding an 

e-mail that already contains attachments, or by adding attachments from the device to 

new e-mails or meeting invitations (either original e-mails, forwarded e-mails, or 

replies). 

 Sending attachments in original e-mails and replies 

1 Create an e-mail (see Creating and sending e-mails on page 39 or Replying to 

e-mails on page 43). 

2 Select Attachments in the DME menu. 

3 In the DME menu, select Add attachment, or 

Select Add media files and then Images or Videos. 

4 If you selected Add attachment, browse to the file you want to add, and select 

Select: 

  

or 

If you selected Images or Videos, DME shows the Gallery location of your 

images or video clips, respectively. In the Gallery, you can now mark one or 

multiple image or video files, and then press the center navigation key to add the 

files as attachments to the e-mail or meeting invitation: 

a) Choose to add images. 
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b) Select a number of images from the Gallery image store using the Nokia 

Options menu, and press the center navigation key. 

 

c) The selected images are now attached. 

 

Repeat items 3-4 to add more attachments. After adding an attachment, you can 

use the DME menu to send attachments locally (see Sending an attachment on 

page 37), remove the attachment from the e-mail or meeting invitation again, or 

open the attachment. 

5 Press Back when you are done. 

 Sending attachments in forwarded e-mails 

1 Forward an e-mail (see Forwarding e-mails on page 43). 

2 You can add attachments in the same way as for original e-mails (see above). 

or 

If the original e-mail contained one or more attachments, and you chose to include 

the attachments in the forwarded e-mail, you can now manage the attachments. 

3 In the DME menu, select Attachments > Open to see the list of attachments that 

were included from the original e-mail. 

4 You can now select one or more attachments to remove them from the e-mail, 

open them, or you can add more attachments in the same way as for original 

e-mails (see above). 

Attachments in forwarded e-mails need not be downloaded to the device before they 

are sent. DME will pull the attachments from the collaboration system when the mail 

is sent, saving transfer costs. 

 Adding attachments to meeting invitations 

1 Create a meeting invitation (see Booking meetings on page 59). 

2 Add attachments in the same way as for original e-mails (see above). 

Note that the DME administrator may have blocked for adding new attachments from 

the device to e-mails. Furthermore, restrictions to the size of attachments apply. The 

default maximum size is 16MB, but this limit may have been increased or reduced by 

the DME administrator. 
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Folder actions 
In each mailbox folder, you can perform a number of actions on one or more items. 
 

Selecting multiple items 

Some functions can be performed on a single item or several, marked items - for 

instance deletion or marking as read.  

To select several items in a folder or list, press the selection key - the Edit/Pencil key 

( ) or the [#] key, depending on device model. If you keep the selection key pressed 

while you scroll up and down, the items in the list will be selected or unselected as 

you scroll. You can also select/unselect the items individually by pressing the 

selection key. DME marks selected items with a check mark (  or ). 
 

Marking read/unread 

When you read an e-mail in the DME client, the e-mail will be marked as read - that 

is, the e-mail icon is open  and not closed . Furthermore, the e-mail will be 

marked as read in the collaboration system the next time you synchronize. You can 

mark an e-mail as unread after reading it, for instance in order to remember reading it 

when you get back to the office, or you can mark unread e-mails as read.  

The actions described below can apply to a number of selected items. See Selecting 

multiple items on page 46 for information about how to select multiple items. 

 Marking one, selected, or all e-mails as read or unread 

1 Open the DME menu, and select Actions. 

2 Select Mark read to mark the e-mail(s) as read, or 

Select Mark unread to mark the e-mail(s) as unread. 

3 Select Selected to mark the selected e-mail(s), or 

Select All to mark all e-mails. 
 

Sorting items 

You can sort items in the Inbox and the other folders ascending or descending by date, 

name, or subject. 

 Sorting items 

1 Open the DME menu, and select Actions 

2 Select Sort 

3 Choose between the following sort methods: 

Descending by date (newest e-mail at the top) 

Ascending by date (oldest e-mail at the top) 

Descending by name (by sender's name, Z-A) 

Ascending by name (by sender's name, A-Z) 

Descending by subject (by e-mail subject, Z-A) 

Ascending by subject (by e-mail subject, A-Z) 

The selected sort order applies to all folders. 

If the folder is sorted by anything other than the default Descending by date, an icon 

in the top bar indicates which sort method is used. 
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Deleting items 

When deleting an e-mail, the e-mail data is removed from the DME client. Depending 

on an e-mail setting, the e-mail can also be deleted on the mail system at the next 

synchronization (see E-mail settings on page 70). 

The actions described below can apply to a number of selected items. See Selecting 

multiple items on page 46 for information about how to select multiple items. 

 Deleting one or more selected items 

1 Select the item or items to be deleted. 

2 Open the DME menu, and select Actions > Delete, or 

Press the Clear key. 

3 Press Yes to confirm the deletion. 

Note that DME will try to prevent the accidental deletion of many items. If you delete 

a large number of items (more than 20 e-mails/meeting invitations or more than 10 

contacts) at a time, a message will ask you if you really want to delete the items on the 

server, the next time the device synchronizes with the server. 

 Deleting the currently open e-mail 

1 Open the DME menu in the e-mail you are reading, and select Delete, or 

Press the Clear key. 

2 Press Yes to confirm the deletion. 
 

Moving items to other folders 

If folder synchronization is enabled, you can move e-mails between folders. The items 

are moved in the collaboration system as well at the next synchronization. 

The action described below can apply to a number of selected items. See Selecting 

multiple items on page 46 for information about how to select multiple items. 

 Moving an item to another folder 

1 Open the DME menu, and select Actions > Move to folder. 

2 The folder selection view is shown (see Navigating the folder tree on page 29).  

3 Browse to a folder, and click the navigation key to move the selected e-mail(s) to 

the folder in question. 

You cannot move e-mails to the Drafts, Sent, Outbox, or Unread folders. 
 

Search 

Using the DME client you can search for contacts in the global address book on the 

collaboration system, search e-mails in your mailbox on the collaboration system, or 

search e-mails already downloaded to the device. 
 

Global Address Book 
The Global Address Book is the shared address book on the collaboration system as 

set up by the network administrators. 
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To create an e-mail message or a meeting invitation, you can open the DME menu and 

select Create as described in Creating and sending e-mails on page 39 or Booking 

meetings on page 59. However, you can also find the recipient or recipients of your 

e-mail or meeting invitation first, and then choose to create a new e-mail or meeting 

invitation with the selected contacts as recipients (not all platforms yet). 

 Finding contacts in the global address book 

1 Open the DME menu, and select Search > Global Address Book (this step has 

already been completed if you open the global address book from a new e-mail or 

meeting invitation). 

You can now search for a contact by Name, E-mail address, Department, Country, 

or Title. 

Note that more fields or different fields may be available if the Global Address 

Book search screen has been customized. See separate documentation about 

customizing the fields in this screen. 

2 Enter a search text in at least one of the available fields, and select Search.  

A connection is made to the collaboration system, and the search results are 

displayed. Depending on a setting on the DME server, the search will either look 

for entries starting with the text you have entered, or entries containing the text 

you have entered. When searching for a name, you can enter both a first and last 

name separated with a space. 

By default a maximum of 10 results are shown, but this value can be changed by 

the DME administrator.  

3 From the search results, you can select contacts the same way as with your local 

contacts. Selected contacts are marked with a . 

4 If you opened the global address book search from an e-mail or meeting invitation, 

select Done from the DME menu to insert the selected contacts into the field from 

which you chose to search for contacts. 

or 

If you opened the global address book search from the Search menu, select 

Create > E-mail or Create > Meeting from the DME menu to insert the selected 

contacts as recipients in a new e-mail or meeting invitation, respectively. 

Apart from the Done or Create options, the DME menu contains the following 

options: 

 New search: Return to the search screen with every option in the search screen 

reset to default values. (Note that this does not apply to the Windows Mobile 

client). 

 Select/Unselect: Select or unselect the currently highlighted contact. 

 Details: View more details about the selected contact. The type of details that can 

be seen depends on choices made by the administrator of the collaboration system. 

Select OK to close the details window. 

 Call: Any phone numbers associated with the highlighted contact are listed. Select 

one, and press OK to place a voice call with the contact, or Cancel to exit the 

menu. 

 Add to contacts: The details of the highlighted contact are copied to a new entry 

in your local contacts. You can edit the details and press Done to save the contact 

as a local contact. 
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E-mails (on server) 
The DME client only synchronizes e-mails from the last number of days specified in 

the e-mail settings (see E-mail settings on page 70). This is called the e-mail 

synchronization window. Sometimes you may need to find an e-mail which is stored in 

a folder in your collaboration system mailbox which is not synchronized to the DME 

client, or which is too old to be synchronized to the client. 

Using this function, you can search for any e-mail stored in any folder of your mailbox 

on the collaboration system. 

 Searching for e-mails on the server 

1 Open the DME menu, and select Search > E-mails (on server) (or select the  

Desktop icon, and choose E-mails (on server). 

2 Complete the search fields in the form: 

1.  Search text: In this field enter the text to search for. 

2.  Field: Select the e-mail fields in which to search for the specified text. 

Click to choose between the following options: 

Any field: All fields in an e-mail are searched for the specified text string. 

Subject: Only the Subject field is searched. 

Subject, Body: Both the Subject and the Body fields are searched. 

3.  Person: In this field enter all or part of the name of the sender of the e-mail 

you are looking for (or recipient in case you are searching your Sent folder). 

4.  Folder: Choose the folder in which the e-mails to be searched are located. 

Click to choose among the mail folders defined in the mailbox on the 

collaboration system. 

Select a folder, and choose Done. For information about folders and folder 

selection, please see Selecting folders on page 51 below. 

5.  Time frame: If you select this check box, DME displays two fields in 

which you can enter a range of dates. This limits the search to e-mails received 

within the selected time frame. The time frame is by default today's date. 

6. Results/page: In this field you can specify the number of results you wish to 

display per page. If your search generates a large number of results, it can take 

a considerable time to download all the results. Therefore you can define how 

many results you want to see at a time, and then browse to the next page of 

results. 

3 Select Search. 

Note that a search can only be executed if one or more of the fields Search text, 

Person, Folder, or Time frame has been completed. If not completed, an error 

message says "Search fields cannot be blank" when you select Search. 

The search results are displayed. Note that the client shows the results in the order in 

which they are presented by the collaboration system. If your collaboration system is 

based on Lotus Domino, the search results are returned in order of relevance. If your 

collaboration system is based on Microsoft Exchange, the search results are returned 

in chronological order (that is, by date). 
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The server sets a limit to the number of search results. By default, the limit is 100 

results. The results are divided into a number of pages, depending on the number of 

results per page you have selected. If more results are returned than the specified 

number of results per page, DME shows the first page. To see the next page, press the 

scroll key to the right, or click the right selection key (or choose Next page in the 

menu). You are then prompted if you want to download the next pageful of results.  

Note that the results are cached on the device for as long as you are performing the 

search. This means that browsing between result pages is instantaneous once the 

results have been downloaded. 

If no results are found, DME shows a message that no matches are found, and you are 

returned to the search screen after confirming the message. 

DME initially only retrieves the header information from the e-mails, that is sender, 

date, and subject. If you click to open an e-mail, DME asks you if you wish to retrieve 

the rest of the e-mail. If you select Yes, the e-mail in question is downloaded from the 

collaboration system and stored on the device. 

On the search results page, the DME menu has the following options: 

 New search: Return to the search screen with every option in the search screen 

reset to default values. 

 Refine search: Return to the search screen, but retain the selections you already 

made. 

 Previous page: If more results were returned than the specified number of results 

per page, and you are not looking at the first page, you can go to the previous 

pageful of results. Alternatively, press the scroll key to the left or click the left 

selection key. 

 Next page: If more results were returned than the specified number of results per 

page, you can go to the next pageful of results. Alternatively, press the scroll key 

to the right or click the right selection key. 

Press Close (or Back on some devices) to close the search and return to the e-mail 

folder from which you opened the search window. 

Please note that for best performance, your mailbox should be indexed. For more 

information about indexing your mailbox, see the documentation for Lotus Notes or 

Microsoft Outlook. 

Note also that if you choose to search in a folder which contains other folders, you 

will get different results depending on your collaboration system:  

 If you use Domino, the search for e-mails will be performed in the selected folder 

only. 

 If you use Exchange, a message will be shown: "Do you wish to include 

subfolders in your search?" If you answer Yes, e-mails in the subfolders of the 

selected folder will be searched as well. 
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Selecting folders 

When you select the folder list button in the Search on server screen, you can see a 

list of e-mail folders. If Folder synchronization is enabled (see Folders settings on 

page 72), you see all folders in your collaboration system mailbox. Otherwise, the first 

time you display this list, you can only choose among All folders, Inbox, Drafts, and 

Sent. However, you can display the actual mail folders in your mailbox on the 

collaboration system by opening the DME menu and selecting Update folders. 

 

The DME client communicates with the server and downloads a list of the mail folders 

you have defined in your mailbox on the collaboration system. See Navigating the 

folder tree on page 29 for information about moving between folders. 
 

E-mails (on phone) 
From any mail folder, you can search for a text string contained in an e-mail in the 

DME client. 

 Searching for a text string 

1 Open the menu, and select Search > E-mails (on phone) (or select the  

Desktop icon, and choose E-mails (on phone)). 

2 Complete the search fields in the form: 

1.  Search text: In this field enter the text to search for. This field cannot be 

blank. 

2.  Field: Select the e-mail fields in which to search for the specified text. 

Click to choose between the following options: 

Any field: All text fields are searched for the specified text string. 

Sender, recipient: Only Sender and recipient fields are searched. 

Subject: Only the Subject field is searched. 

Subject, Body: Both the Subject and the Body fields are searched. 

3.  Folder: Choose the folder in which the e-mails to be searched are located. 

Click the navigation key to choose between the available mail folders. See 

Navigating the folder tree on page 29 for information about moving between 

folders. Only the folder shown in this field is searched (any subfolders are not 

searched). 
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3 Select Search. 

The search results are displayed. If no results are found, DME shows a message that 

no matches are found, and you are returned to the search screen after confirming the 

message. 

 

The DME menu has the following options: 

 New search: Return to the search screen with every option in the search screen 

reset to default values. 

 Refine search: Return to the search screen, but retain the selections you already 

made. 

 Previous page: If more results were returned than the specified number of results 

per page, and you are not looking at the first page, you can go to the previous 

pageful of results. Alternatively, move the navigation key to the left. 

 Next page: If more results were returned than the specified number of results per 

page, you can go to the next pageful of results. Alternatively, move the navigation 

key to the right. 

 Actions: This submenu lets you delete all the found e-mails, the selected 

e-mail(s), remove all attachments from the found e-mails, or place a call to the 

sender of the e-mail. 

Press Close (or Back on some devices) to close the search and return to the e-mail 

folder from which you opened the search window. 
 

Calendar 

DME contains a complete, built-in calendar, which you can use to get an overview of 

your appointments, and from which you can create new meetings and invite other 

people to the meetings. Meeting invitations from other people are received in the 

DME Inbox, and transferred to the calendar when accepted. Meetings that you create 

for yourself are saved directly in the Calendar. Meetings with other participants are 

also saved directly in your Calendar, and sent as invitations to the other participants 

(and resources) at the next calendar synchronization. 
 

Interaction with native calendar 
The DME calendar may be integrated with the calendar application which is native to 

your device. This depends on a security option in Calendar settings (note: requires 

DME Server 3.5). 

The security setting is called Calendar mode, and has three options: 
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 Open 

In Open mode, meetings, all-day events, and anniversaries created on the 

collaboration system or in the DME Calendar are also shown in the native calendar 

(insofar the native calendar supports the features of the DME Calendar - for 

instance, meeting attachments are not linked to calendar entries in the native 

calendar).  

Personal appointments created and edited from the native calendar application are 

synchronized with your collaboration system. However, you cannot invite other 

people or perform other advanced actions. 

See also Recurring meetings on page 59. 

 Mixed 

In Mixed mode, meetings, all-day events, and anniversaries created on the 

collaboration system or in the DME Calendar are also shown in the native 

calendar. However, any potentially sensitive information is replaced by a message 

from DME. The only data shown are Start, End, and Alarm times. Thus, a meeting 

in the native calendar might look like this: 

Subject: Secured by DME! 

Body: Please log in to the DME calendar to see content. 

Location: Please log in to the DME calendar to see content. 

Start time: 10:00 

End time: 11:00 

Alarm time: 9:45 

Furthermore, Subject, Body, and Location are encrypted by DME when saved to 

the device disk. 

Personal appointments created from the native calendar application will be secured 

after synchronizing with the collaboration system. 

 Secure 

In Secure mode, all calendar entries created on the collaboration system or in the 

DME Calendar are kept in DME. There is no interaction with the native calendar. 

This includes alarms - no alarms will be shown for calendar events in Secure 

mode. If you rely on calendar alarms, but also want high security, choose the 

Mixed mode option. 

Personal appointments created from the native calendar application are not 

synchronized with the collaboration system. 

See also Calendar settings on page 72. 
 

Switching calendar modes 

If you switch the calendar mode, DME will process your calendar entries after you 

synchronize. 

 Switching from Open/Mixed to Secure mode: 

All entries in the native calendar are merged into the DME calendar, and are then 

removed from the native calendar. Any entries that you subsequently create in the 

native calendar will remain there and will not be synchronized with the 

collaboration system, as there is no longer any interaction with the DME calendar. 

 Switching from Secure to Open/Mixed mode: 

Calendar items within the calendar synchronization window are copied out from 

the DME calendar to the native calendar. 
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In Open mode, DME uses both the native calendar database and the DME calendar 

for storing and displaying calendar entries. The fields supported by the native calendar 

are stored there, such as Subject, Body, and Location. The fields not supported by the 

native calendar are stored in DME. This is the most efficient way to store calendar 

entries.  

When you switch from Open/Mixed to Secure mode, all fields are moved from the 

native calendar into the DME calendar, and synchronization with the collaboration 

system only affects the DME calendar. When you switch back to Open/Mixed mode, 

the calendar entries are split up again in the way mentioned above, and are thus visible 

in the native calendar. 

When switching from Open to Mixed mode, the Subject, Body, and Location fields 

are copied to the secure DME calendar, and a message from DME is entered in the 

native calendar instead. Switching from Mixed to Open mode reverses this process. 
 

Calendar views 

To view the calendar entries in the DME calendar, select the  icon from the 

Desktop, or select View > Calendar in the DME menu. 

The calendar opens on today's date in the Day view. Using the DME menu, you can 

choose to see your calendar entries in three different views: 

 Day view: See all calendar entries for one day. Browse to the previous or next day 

using the left or right navigation key (Android: swipe left or right). The title text 

tells you the day in the week and the date of the day you are currently viewing. For 

each calendar entry, the time and subject of the entry are shown. 

 Week view: See all calendar entries for one week. Browse to the previous or next 

week using the left or right navigation key (Android: swipe left or right). The title 

text tells you the number and starting date of the week you are currently viewing. 

For each calendar entry, the week day, time, and subject of the entry are shown. 

 Month view: See all calendar entries for one month. Browse to the previous or next 

month using the left or right navigation key (Android: swipe left or right). The title 

text tells you the name of the month and the year you are currently viewing. For 

each calendar entry, the month name, date, time, and subject of the entry are 

shown. 

To switch between the views, select View day, View week, or View month in the 

DME menu. 
 

Go to date 

To show a certain date in the DME calendar, select Go to date in the DME menu. 

 

Enter the desired date. You can use the left and right navigation keys to move between 

the fields in the date, and the up and down keys to spin the numbers within each field. 

Select OK, or press the center navigation key to go to the selected date. The date will 

be shown in the Day view. 

To go to today's date, select Go to today in the DME menu. 
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Calendar actions 

From each view, you can select the following actions in the DME menu (in addition to 

the Go to ... and View ... options): 

 Create meeting: Create a new meeting. The default date set for the new meeting 

is the currently viewed day. In the Week view and the Month view, the meeting date 

is set to the first day within the viewed range of days, for instance the first in the 

month currently viewed. If that date has passed, today's date is suggested as the 

meeting date. 

 Synchronize: Perform a manual calendar synchronization. See Synchronization 

overview on page 13 for more information. 

 Tools > Import calendar: Import all calendar items from the collaboration 

system. See Synchronization overview on page 13 for more information. 

 About DME: See information about your version of the DME client. 
 

Viewing and editing meetings 

To view details about a meeting in the calendar, move to it, and click to open it. You 

can now see all the fields that have been completed for this meeting, but you cannot 

initially change any fields. 

Your options in the DME menu depend on whether you organized the meeting in 

question (you are the chair) or you were invited as a participant. 

 Calendar options for the meeting chair 

If you are the chair of the meeting, the following options are available: 

 Edit: Select this option if you want to change any of the details in the meeting, 

including removing and adding participants. All fields in the meeting invitation are 

now opened, and you can make any change you want. 

Note: The Domino collaboration system permits the use of formatted text and the 

embedding of attachments in the meeting description. If the meeting description 

contains attachments, you will not be able to edit the description on the device. If 

there are no attachments, and you edit the Description field on the device, any 

formatting and any embedded objects in the field will be lost when the calendar 

event is synchronized back to the collaboration system. 

Select Attachments in the DME menu to add or remove attachments in the 

meeting. See Sending attachments on page 44. 

When you are done editing the meeting, you may select Check free time in the 

DME menu to verify that all participants are free at the time in question, if you 

have changed the meeting time or date. For more information, see Checking free 

time on page 62. Select Save in the DME menu to save your changes. You are 

prompted to enter a comment about the reason for changing the meeting, which is 

sent to each participant when you synchronize. If you remove a participant from 

the list of required participants, the participant receives a meeting cancellation 

notice, and the meeting will be removed from the calendar of that participant. 
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 Reschedule: This option is available if you are the chair, and you have invited 

other people to the meeting. Select this option if you want to move the meeting to 

another date or time. A new screen opens, letting you set a new date and time for 

the meeting. 

 

Change the date and time. You may now select Check free time in the DME 

menu to verify that all participants are free at the time in question. For more 

information, see Checking free time on page 62. 

Select Save or Send and save in the DME menu to save your changes. You are 

prompted to enter a comment about the reason for rescheduling the meeting, which 

is sent to each participant when you synchronize. 

 Cancel meeting: This option is available if you are the chair, and you have invited 

other people to the meeting. Select this option if you want to cancel and delete the 

meeting. The meeting will be removed from the calendar of all participants. You 

are prompted to enter a comment about the reason for cancelling the meeting, 

which is sent to each participant when you synchronize. 

Note: If your collaboration system is Exchange 2003, DME is unable to process 

meeting cancellation notices. This means that if you receive a notice about a 

cancelled meeting, you must accept the cancellation in Outlook or Outlook Web 

Access (the OWA webmail). 

 Delete: This option is available if you are the chair, and you have not invited other 

people to the meeting (it is a personal appointment or similar). Select this option if 

you want to cancel and delete the appointment. The appointment will be removed 

from your calendar in DME immediately, and from your collaboration system 

when you synchronize. 

When you save any changes, DME asks you if you want to synchronize the calendar 

immediately. 
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 Calendar options for meeting participants 

If you are a participant in the meeting, and not the chair, the following options are 

available: 

 

 Edit: Select this option if you want to change details in the meeting. As a 

participant, you only have access to toggle the Private status of the meeting and the 

Alarm (and possibly set the alarm time). After editing these fields, select Save in 

the DME menu to save your changes. 

 Decline 

 Propose new time 

 Delegate: For information about these three options, see Responding to meeting 

invitations on page 57. Note that selecting Decline or Delegate removes the 

calendar entry from the calendar immediately. 

After making any changes, DME asks you if you want to synchronize the calendar 

immediately. 
 

Responding to meeting invitations 
When meetings are booked on the collaboration system, all invited participants receive 

a meeting invitation by e-mail, containing information about the meeting. 

In the DME client, a meeting invitation is recognized by a clock/e-mail icon in the 

Inbox. See E-mail icons on page 33 for more information. 

 Responding to a meeting invitation 

1 Open the meeting invitation. Browse through the pages of the invitation to see the 

subject and time of the meeting, who organized the meeting, who have been 

invited (participants), and any information about location and resources involved 

in the meeting. 

2 In the DME menu, you can now choose among a number of options. Most of the 

options are available on all supported collaboration systems, but there may be 

differences, which are noted below.  

Furthermore, the description of the actions pertain to the standard way of inviting 

to meetings. For instance, in Domino the chair can select options in the meeting 

invitation in Notes specifying that he or she does not want to receive responses 

from invitees (participants), wants to prevent counter-proposals, or wants to 

prevent delegation. Such options are naturally observed by DME, even if they are 

not mentioned in the descriptions below. 

The following options may be available: 

 Accept: Accept the meeting invitation. The meeting is created in the calendar, 

and a notification of your acceptance is sent to the meeting organizer/chair. 
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 Decline: Decline the meeting invitation. Notification of this is sent to the 

organizer/chair and any other participants. 

 Tentatively accept: If you want to attend the meeting, but you are not sure 

that you are available at the proposed time, you can tentatively accept the 

meeting. This way the meeting is booked in your calendar, but the time still 

appears free for other users. Note: On Exchange 2003 systems, this action is 

not available for recurring meetings. 

 Propose new time: If you would like to attend, but you are not available at the 

proposed time, you can propose a new time (also called countering the meeting 

proposal). Selecting this option opens a new screen in which you can select a 

new time, date, and time zone for the meeting. 

 

When you are done, you can open the DME menu and select Send to send the 

new proposed time, or Check free time to see if the new proposal conflicts 

with the calendars of any of the required participants. For more information, 

see Checking free time on page 62. When you send the new proposed time, 

the meeting chair/organizer will receive an e-mail with the subject Countered: 

and the subject of the meeting. 

Please note that once the calendar entry has been accepted, you are not able to 

change the time zone of the calendar entry if you subsequently edit the 

calendar entry from your calendar to propose a new time. Note: On Exchange 

2003 systems, this action is not available for recurring meetings. 

 Delegate: If you are unable to attend the meeting, you may want to send 

someone else in your stead. Choose Delegate, and select another user from 

your local or global address book. The Delegate field functions as other 

recipient fields, with type-ahead selection of recipients and the ability to 

choose from the local and global address books. See Entering recipients on 

page 40 for more information. 

 Show calendar: Open your DME calendar on the day of the meeting so you 

can check your schedule for that day. Select Back to return to the meeting 

invitation. 

 Delete: Delete the current meeting invitation without performing any action 

with it. To get the meeting invitation back into your mailbox, you must 

synchronize your e-mail (unless the option Delete only locally is set to No in 

E-mail settings (see E-mail settings on page 70), in which case the invitation 

will be deleted on the server also at the next synchronization). Note: On 

Exchange 2003 systems, this action is not available for recurring meetings. 
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3 When you accept, decline, tentatively accept, propose a new time, or delegate a 

meeting invitation, you are given the option to add a comment. If you enter a 

comment, it is sent to the organizer/chair. Select Continue / Send to complete the 

action, or Cancel / Close to return to the meeting invitation. Note: On Exchange 

2003 systems, not all actions allow you to reply with comments. 

4 When you respond to a meeting invitation by using any of the above actions, the 

e-mail containing the invitation is removed from your Inbox, and if you accepted 

the meeting, your calendar is updated on the collaboration system at the next 

calendar synchronization. 
 

Recurring meetings 
Recurring meetings created on the collaboration system are synchronized to DME as a 

series of individual appointments. This means that if you edit one in a series of 

meetings, only that instance of the meeting series will be changed. If you want to edit 

the entire series, you must do so in Microsoft Outlook or Lotus Notes. 

Recurring meetings created on the device are sent to the server as a true series or 

recurring meetings, not as individual events. If you create a recurring meeting on the 

device without an end date, the DME server will add an end date automatically. The 

end date will be five years in the future. 
 

Booking meetings 
You can book meetings in your corporate calendar from the DME client. You can 

invite people to attend the meeting, and you can reserve rooms and resources. This 

basically works the same way as booking meetings in your collaboration system. 

 Creating a new meeting 

1 There are several ways to start the creation of a new meeting: 

 From the Desktop or a mailbox: Select Create > Meeting in the DME menu. 

 From the Calendar: Select Create meeting in the DME menu, or tap the Add 

(plus) icon (not all platforms). 

 From the Desktop, select the New meeting icon . 

 Or press the shortcut you have defined for New meeting from anywhere in 

DME (not all platforms). 

2 Enter meeting details: see Entering meeting details on page 60. 

3 Add participants: see Adding participants on page 61. 

4 Enter a location and book resources: see Location and resources on page 61. 

5 Check to see if the calendars of all participants are free at the proposed time: see 

Checking free time on page 62. 

6 Add attachments: see Sending attachments on page 44. 

7 From the DME menu, select Save and send (if participants or resources have been 

invited), or Save (if the meeting is for yourself only). 

The meeting is created in your calendar, and meeting invitations are sent to the 

selected participants and resources at the next calendar synchronization. 

Note that you can create a new meeting invitation by selecting recipients first from a 

search and then creating the meeting invitations. For more information, see Global 

Address Book on page 47. 
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During the creation of a meeting, you can also choose Save as draft in the DME 

menu or Close. Selecting Save as draft saves the meeting as a draft, allowing you to 

interrupt your work on the meeting proposal for a later time. The Close option closes 

the current meeting draft, and prompts you if you want to save it as a draft before 

closing it.  

The meeting is shown in your calendar as a regular meeting, but with a blue, hollow 

triangle on top of it, and it will not be synchronized to the collaboration system. Please 

note that draft meetings are not synchronized with the server. This means that if you 

import your calendar from the server, any draft meetings in your DME calendar on the 

device will be lost. 
 

Entering meeting details 

 

The Meeting details tab contains the following fields: 

  Subject: Enter a subject for the meeting. 

 All day: Mark the meeting as an all-day meeting. When you select this field, you 

cannot enter start and times for the meeting. The meaning of "all-day" depends on 

which collaboration system you are using: 

Lotus Domino: All-day events in Domino do not support the use of other 

participants, rooms, or resources. An all-day event created in Domino will only 

display a Details tab and a Location tab when it is synchronized to the client - it is 

not possible to add participants and resources to the event. 

When you create an all-day event on the client, you are able to add participants 

etc. to the event. However, when the event is synchronized to the server, it is 

created in Domino as a regular meeting, and the client will reflect this also (even 

though the All day field is still checked). 

MS Exchange: In Exchange, you are able to invite participants and book resources 

for all-day events - the All day field simply signifies that the event has no time 

constraints. 

 Symbian users should be aware that all-day events created in the native 

device (as "Memos") will appear as all-day events in the DME calendar, but the 

meeting type cannot be changed in DME. 
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  Date and time: Enter starting and ending dates and times for the meeting. 

  Time zone: Enter the time zone for the starting and ending times. See Time 

zones on page 7. 

  Alarm: Enable or disable the alarm. When the alarm is enabled, you can enter 

a date and time for when the alarm should go off. 

  Private: Mark the meeting as private. This means the the meeting details are 

not visible to other people in the collaboration system when you sync the calendar 

item, but your time will appear booked. 

 Description: Enter a description of the meeting, agenda, etc. 
 

Adding participants 

 

In the Participants tab, you can add meeting participants from Local contacts on the 

device and from the global address book on the server. You can enter Required 

participants ( ), Optional participants ( ), and FYI participants ( ). 

 Entering meeting participants 

1 Click one of the Participants fields. The field functions as other recipient fields, 

with type-ahead selection of recipients and the ability to choose from the local and 

global address books. See Entering recipients on page 40 for more information. 

See Global Address Book on page 47 for information about selecting participants 

before creating the meeting. Participants selected from a Global Address Book search 

result are added to the required participants field ( ). 
 

Location and resources 

 

In the Location and resources tab, you can enter a location for the meeting, and book 

rooms and resources that are available in the collaboration system. 

In the form, you can enter information into the following fields: 
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  Location: Here you can enter free text describing the location of the meeting - 

for instance an office, a country or a city. 

  Rooms: Here you can select one or more of the rooms available in the 

collaboration system. See below. 

  Resources: Here you can book one or more of the resources available in the 

collaboration system. See below. 

Before selecting rooms or resources, you must download the available rooms and 

resources from the collaboration system to your device. 

 Downloading rooms and resources 

The first time you click either of the Rooms or Resources fields, DME will 

download a list of rooms and resources from the server. Subsequently, you can 

refresh the list of resources by selecting Get resources in the DME menu, and 

then select Yes to download rooms and resources from the collaboration server. 

 Selecting rooms and resources 

1 Move the cursor to the Rooms or Resources field. 

2 Open the drop-down list by clicking. 

3 You may have to select which site you want to select your rooms and resources 

from by clicking. Sites are marked with a . If your organization only uses one 

site, the list of rooms or resources is shown directly. 

4 Scroll up and down in the list of rooms or resources, and mark the rooms or 

resources you want to add. Note that if the people capacity of the room is entered 

in the collaboration system, it is shown in the list. 

 

5 Select Done. 

The selected rooms or resources are entered into the field in question. 
 

Checking free time 

When participants, rooms and resources have been added, you can check if they are 

available within the specified time frame. This can be done from any of the tabs. 
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 Checking free time 

1 Open the DME menu, and select Check free time. 

After DME has checked on the server, you will see a message indicating whether 

all participants and resources are available or unavailable within the selected time 

frame. 

 

2 Select Yes to show alternative time frames 

or 

Select No to keep the current time frame. 

If you select Yes to show alternatives, you will see a list of time frames within 

which all participants and resources are available. 

 

3 Scroll up or down to select a new time frame. 

4 Select Done to use the selected time frame or 

Tap the time frame you want to use (Android) 

The meeting details are changed to reflect the update. 
 

Contacts 

The Contacts application is populated by DME and reflects your personal address 

book on the collaboration system. Changes in either address book are synchronized to 

the other, if the setting Contacts sync. is enabled (see Contacts sync. settings on page 

74). 

Whenever you create an e-mail or book a meeting (not iPhone 2.x), you can choose 

recipients from the Global Address Book or from your local contacts. See Address 

book integration see "Entering recipients" on page 40, on page 41 for more 

information. 
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 See Importing items on page 15 for information about special considerations in 

connection with the initial synchronization or import of contacts from the 

collaboration system. 

 Note that the Birthday field in contacts is not synchronized with the 

collaboration system, as Java devices only support dates from 1970 and onwards. 
 

To-dos 

A to-do item is a special type of calendar item and is synchronized with your 

collaboration system by DME.  

Contact your DME administrator for information about special considerations in 

connection with initial synchronization or import of to-dos from the collaboration 

system. Also see Importing items on page 15. 

For a to-do to be included in the synchronization from the collaboration system to the 

device, the following criteria must be fulfilled by the to-do on the collaboration 

system: 

1 A due date has not been specified, and it has not been marked as complete 

(Domino only). 

2 Or the to-do is overdue and not marked as complete, regardless of the values in the 

starting date and due date fields. 

3 Regardless of the above, a to-do is included if either the starting date or the due 

date is within the time span set in To-do settings on page 74 (the sync window). 

Examples: 

The sync window is set to 10 days in To-do settings, and today is April 15th.  

1 A to-do on the collaboration system was created on March 23rd with a due date on 

April 17th. This to-do is synchronized to the device because the due date is within 

the 10-day sync window specified in the To-do settings. 

2 Another to-do was created on March 3rd, with a due date of March 16th. It has not 

been marked as completed. This to-do is synchronized to the device. When it is 

marked as completed, it will no longer appear on the device. 
 

Files 

If file synchronization is enabled, files can be synchronized using scheduled sync or 

manual sync. Files can be synchronized in one of three ways, which is determined by 

the sync method selected in the file rule set up by the DME administrator: 
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 One-way, just like receiving an e-mail: The files are downloaded to your device if 

updated on the server since your last sync. 

 Execute: The files are downloaded and executed on your device, if they were 

updated on the server since your last sync. 

 Two-way, just like editing a meeting invitation: The files are downloaded to your 

device if updated on the server since your last sync, or uploaded to the server if 

you updated the files on the client since your last sync. 

For a file to be of use on the device, the file type in question must have an associated 

viewer. Not all devices are for instance able to view Word documents. For more 

information, consult your DME administrator. 
 

Tools 

The Tools menu in the DME menu contains options that apply to the DME client in 

general. The menu contains the following items: 

 Settings: Control the look and feel and the operation of your DME client. See 

Settings on page 66. 

 Import: Refresh the contents of your DME client with a new copy from the 

server. Care should be taken before importing contacts and calendar items. See 

Importing items on page 15. 

 Change password: With this function, you can change your network password. 

See Changing mailbox passwords on page 9. 

 Set PIN code: With this function, you can temporarily replace your collaboration 

system password by a simpler PIN code for use on the DME client. See Logging 

in using a PIN code on page 11. 

 Out of office: With this function, you can enable, disable, and modify your 

Out-of-Office text. See Out of office. 

 SmartEncrypt: Open the SmartEncrypt on-the-fly encryption application 

(add-on; see the SmartEncrypt Quick Guide for more information). This applies to 

Nokia S60 and UIQ devices only. 

 Log: Displays the event log, which is kept by the DME client. The log can be 

useful in support questions. See If you need further assistance on page 81. 
 

About DME 

When you select About DME in the menu, a window displays information you can 

use in connection with helpdesk inquiries. Apart from the product name and a 

copyright notice, The window shows the following information: 

 Version number (for instance 3.5.5) 

 Build number and date (for instance 2 2010-09-23) 

 Amount of free memory left on the device 

 Language setting of the Symbian OS 

 The remaining battery life in percent 

 The unique ID of the DME phone model (only shown in special debug mode) 

Your helpdesk may ask for this information. See also If you need further assistance 

on page 81. 
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Settings 

When a new device is created in DME, a set of default settings for the device is sent to 

the client the first time the device connects with the server, or when a new user takes 

over an existing device. These settings should represent your company's security 

policy.  

Note that the DME administrator may have blocked your access to changing any or all 

of the settings described in the following sections. The permitted range of values is 

determined by the corresponding setting on the server, and is displayed in parentheses 

after the field name in the screen where you make the change. 

The "Installation Best Practise" guide contains information for DME administrators 

about recommended settings and permitted range values. 
 

General settings 
 Server path 

This is the path to the DME server. The value is set automatically when installing 

the DME client. The server path should rarely be changed, and only if your DME 

Administrator tells you to. 

 Phone number 

The phone number of the device. The DME server needs to know your phone 

number for sending SMS messages and pushing downloads etc. to the device. 

 Time zone (client 3.0.1 and earlier) 

In this field you can specify the time zone you are currently in from a list of time 

zones. Server time is default, meaning same time zone as the server. For more 

information about time zones and DME, see Time zones - previous versions on 

page 8. 

 Launch on startup 

Select Yes/Enabled to make the DME client launch every time you start your 

device. This is default and highly recommended for security purposes. 

Select No/Disabled if you want to start the DME client manually. 

 E-mail key 

If you select Enabled, you can select the DME application as the program to be 

launched when you press the Mail one-touch button  on your device. For 

information about setting this feature on your device, see your device manual - 

search for "Active standby" or "Shortcuts". 

If you select Disabled, you cannot set up your device to launch DME when 

pressing the Mail button. 

 Homescreen integration 

With this setting, you can choose to show a notification with the number of new 

e-mails in DME. The notification pops up on the homescreen when a new e-mail 

arrives. When you click the navigation key (or tap the notification area - touch 

devices only), DME opens or is brought to the foreground. If you press any other 

key (or tap outside the notification area - touch devices only), the notification 

disappears, and you can continue working with your phone. 

You can choose among the following options: 
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 Repeat: The notification is shown for approx. 30 seconds every time you go to 

the homescreen. This means that the notification will reappear whenever you 

navigate to the homescreen from another application; when the phone wakes 

from screensaver mode; or when you press any button after the notification has 

disappeared by itself (that is, after 30 seconds). The notification will be 

removed when you open DME and open any of the new e-mails. 

 Show once: The notification only appears once - when you click (or tap) 

something to make the notification disappear, it will not reappear until a new 

e-mail arrives. 

 Disable: The homescreen integration feature is disabled. 

 Desktop Close key 

In this field you can specify the action of the secondary key when the Desktop is 

shown. The following choices are available: 

 Lock: This is the default setting. Pressing the secondary key from the Desktop 

locks DME and shows the Login screen. 

 Hide: If you select this option, pressing the secondary key will hide (minimize) 

DME without logging out the user. This corresponds to pressing the red 

end-call key. 

 Login Close key 

In this field you can specify the action of the secondary key when the Login 

screen is shown. The following choices are available: 

 Exit: This is the default setting. Pressing the secondary key exits the DME 

application. 

 Hide: If you select this option, pressing the secondary key will hide (minimize) 

DME without logging out the user. This corresponds to pressing the red 

end-call key. Note that by selecting this, both the Exit action and the Login 

action are moved in as sub-items in the DME menu. 

 GPRS timeout 

Select After 1 min. to force the DME client to shut down the GPRS connection 

after one minute of inactivity. This is the default value, and is recommended to 

save connection costs. 

If you select Always on, the GPRS connection is never shut down. 

This setting does not affect network push. 

 1. access point 

In this field you can specify the primary access point used to connect to the DME 

server. It is recommended to enter the fastest and/or cheapest access point as the 

primary access point, such as WLAN, and let it fall back to GPRS as a secondary 

access point. 

 2. access point 

In this field you can specify the secondary (fallback) access point used to connect 

to the DME server, if the primary access point fails or becomes unavailable. 

 3. access point 

In this field you can specify the tertiary (fallback) access point used to connect to 

the DME server, if the primary and secondary access points fail or become 

unavailable. 
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 Network push 

If this function is enabled, the device is set up to receive network (IP) push. This 

means that notifications are received over the GPRS network instead of by SMS. 

The result is faster and usually cheaper notification. This requires that the DME 

server is set up correctly. If the GPRS network is for some reason unavailable, the 

DME server will detect this and send notifications by SMS instead. This system of 

falling back to SMS is called AdaptivePush™. Whenever network push is enabled 

and working on your device, a flash icon  is displayed next to the DME logo at 

the top of your DME client. 

Note that this feature may be disabled if you are roaming. For more information, 

see Roaming on page 19. 

 Network push path 

If network (IP) push is enabled, you must supply a path to the server providing 

the network push connection. This path is usually pushed to your device by the 

DME server. Please contact your DME administrator for more information. 

 IM awareness 

If your company uses the IBM Sametime instant messaging (IM) application, 

you can select this field to see the Sametime status of your Sametime contacts 

(buddy list). If you do this, a symbol next to the name of the sender of an 

e-mail in a mailbox indicates his or her Sametime status: Away , In a meeting 

, Do not disturb , or Available . Please note that in order to use this feature, 

Network push must be enabled as well (see above). 
 

Security settings 
With these settings, you specify the security aspects of DME on your device. 

 Logout timeout (min) 

The DME client is locked automatically after the specified number of minutes of 

inactivity. The value 0 means never logout automatically (not recommended). 

Permitted range: 0-60 minutes. 

 Action on SIM change 

In this field you can choose how the DME client should react when a new SIM 

card is inserted into the device. You may need more than one SIM card, for 

instance if you travel and use local prepaid SIM cards. However, simply allowing 

SIM card changes poses a security threat, as a malevolent user might steal a device 

and insert his own SIM card in order to (potentially) gain access to files and other 

data on the device. Therefore you can choose among three options in this field: 

 None 

If you select this option, the DME client will do nothing when a user changes 

SIM cards. This is usually not recommended for the above stated reasons. 

 Flush data 

If you select this option, the DME client will flush (delete all DME data from) 

the device if another SIM card is inserted. For more information, see Data 

security on page 9. 

 Lock device 
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When the DME client detects the SIM card change, the client automatically 

switches to Lock device mode (Shell protection). You now have to log in to 

DME in order to use the device. You have as many chances to enter the correct 

password as the option Limit on password attempts specifies. Just before 

logging in, DME checks if the current SIM card has been used before. If it has 

not, the user is prompted to enter the phone number for the new SIM card. 

This phone number and the SIM card identification number (IMSI) are stored 

and thus recognized the next time the same SIM card is inserted. A maximum 

of 62 pairs of phone numbers and SIM card IDs can be stored in this way. 

 Lock Messaging 

If you select Enabled, you can only access the messaging applications 

(SMS/MMS etc.) on the device when you are logged in to the DME client. If you 

log out of DME and attempt to open the messaging application, the following 

message is shown: 

 

When you accept the message, focus is changed to DME (or DME is launched), 

allowing you to log in. When logged in, focus is automatically changed back to the 

messaging application.  

If you select Disabled, the messaging applications are never locked. 

 Lock Calendar 

If you select Enabled, you can only access the calendar on the device when you 

are logged in to the DME client. See Lock Messaging above. 

If you select Disabled, the calendar is never locked. 

 Lock Contacts 

If you select Enabled, you can only access the Contacts application on the device 

when you are logged in to the DME client. See Lock Messaging above. 

If you select Disabled, the Contacts application is never locked. 

 Lock VoiceExtender 

If you select Enabled, you can only access the VoiceExtender application on the 

device when you are logged in to the DME client. See Lock Messaging above. 

If you select Disabled, the VoiceExtender application is never locked. 

 Lock device 

If you select Enabled, the device is completely locked when you log out of the 

DME client. You are only able to receive voice calls, make emergency calls, 

receive (but not view) text messages, and respond to calendar alarm messages. For 

maximum security, enable the setting “Launch on startup” in the General settings 

(see General settings on page 66). This way, this level of security is maintained 

even if the device is rebooted. Furthermore, the DME client will automatically 

restart if it should crash. 

If you select Disabled, the device is not locked when you log out of the DME 

client. 

 Private key password 

In this field you can specify your password for your private key. Your private key 

is used for decrypting encrypted messages sent to you, and for signing private 

messages. If you do not enter a password here, you cannot read encrypted 

messages or sign new messages from your mobile device. 
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If your collaboration system is using Notes Encryption, you must enter the 

password for your user ID file. 

If your collaboration system is using S/MIME, enter the password for your private 

key in this field. You must also upload your personal certificate to the DME server 

(using myDME).  

For more information about Notes Encryption, S/MIME, and myDME, please 

contact your DME administrator. 

 Client certificate 

If Client signing is enabled on the DME server, you can only establish a 

connection with the server if your device is known and trusted by the server. This 

is achieved through a system of certificates. If a new certificate is generated for the 

device, you will need to delete the existing certificate on your device. If the value 

in this field is Select to remove, a client certificate is in force on your device, and 

you can delete it. You should only do this if you are asked to do so by a DME 

Administrator, as you will not be able to log on again until the DME Administrator 

initiates the creation of a new certificate. 
 

E-mail settings 
In the e-mail settings screen you specify the synchronization and other aspects of 

e-mail in the DME client on your device. 

 E-mail sync. 

If you select Enabled/On, e-mail synchronization is enabled. This setting affects 

push mail, e-mail pull, manual synchronization, and scheduled sync. 

If you select Disabled/Off, e-mails are never synchronized. 

 Days back 

When e-mails are synchronized, e-mails from the last number of days selected 

here will be synchronized and available in the Inbox. Permitted range: 0-99 days. 

 Mail alert 

In this field you can specify the sound you want played when a new mail is 

received by DME. 

 Alert volume 

In this field you can specify the volume of the alerts you hear when a new 

e-mail arrives. 

 Alerts start 

In this field you can specify the time of day from which you want to begin 

receiving audible alerts when a new e-mail arrives. Use the local time format, 

for instance hh:mm:ss or hh:mm:ss am/pm. Example: 08:00 or 08:00 am. 

 Alerts end 

In this field you can specify the time of day from which you no longer want to 

receive audible alerts when a new e-mail arrives. Use the local time format, for 

instance hh:mm:ss or hh:mm:ss am/pm. Example: 18:00 or 06:00 am. 

 Vibrating alert 

If you select Enabled, the device vibrator will be activated when a new mail is 

received by DME. 

 Send immediately 

If you select No, e-mails are stored in the Outbox folder when you select Send, 

and are not sent until the next scheduled or manual synchronization. 
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If you select Send only, e-mails created on the device are sent immediately when 

you select Send from a new e-mail or meeting invitation, but any new items are 

not retrieved from the server. This significantly reduces the load on the server and 

the time it takes to synchronize. 

If you select Send & Retrieve, e-mails created on the device are sent immediately 

when you select Send from a new e-mail or meeting invitation - that is, a regular 

e-mail synchronization is performed. 

 Delete only locally 

If you select Yes/On, e-mails deleted from the DME client will only be deleted on 

the device, and not on the collaboration system. This is the default. 

If you select No/Off, e-mails deleted on the client will be removed from both the 

DME client and the mail system at the next scheduled or manual synchronization. 

 Signature 

Any text you enter in this field will be appended to all new e-mails sent from the 

DME client. You typically use it for adding a signature. Note that the DME 

administrator can add another text to be appended to e-mails, called an "E-mail 

disclaimer". DME will add the signature from this field first, and then the e-mail 

disclaimer will be added by the DME server at the very end of the e-mail (after 

any reply history). 

 Font size 

In this field you can choose the font size used in the DME client. Choose between 

Small, Normal (default), and Large. 

 E-mail pull 

If you select Enabled, client-initiated (pull) synchronization of e-mail is enabled. 

This corresponds to the Scheduled sync. see "Scheduled sync. settings" on page 

74, but is independent of the synchronization schedule set up on the DME server. 

Select Disabled to disable the client-initiated sync. of e-mail. 

Note that this feature may be disabled if you are roaming. For more information, 

see Roaming on page 19. 

 Pull interval 

If E-mail pull is enabled, the client will initiate a sync. every number of 

minutes selected here. Permitted range: 10-120 minutes. 

 Start time 

In this field you can specify the time of day after which client-initiated pull 

should start, if this is enabled. Use the local time format, for instance 

hh:mm:ss or hh:mm:ss am/pm. Example: 08:00 or 08:00 am. 

 End time 

In this field you can specify the time of day at which client-initiated pull 

should end, if this is enabled. Use the local time format, for instance hh:mm:ss 

or hh:mm:ss am/pm. Example: 17:30 or 05:30 pm. 

 Run on weekends 

If you select Yes, client-initiated pull will continue to run over the weekend. 

If you select No, client-initiated pull will not run on weekends. 

 Call privacy 

In this field you can specify whether the device should send the caller ID when 

calling a number directly from an e-mail. 

 Phone default: Use the settings from the device to determine whether to use 

the network operator's settings, send, or hide the user’s number. 

 Always ask: Ask the user whether or not to send the caller ID. 



72 

 

DME Client User Guide 3.5.5 : ©2011 Excitor A/S 

 

 Send my number: Send caller ID whenever possible. 

 Hide my number: Never send caller ID. 

 Show received time 

If you select Yes, a column is added to the mailbox folders with the date on which 

the e-mail was sent or received. 
 

Folders settings 
The folder settings screen is only visible if the DME administrator has enabled folder 

synchronization on the server. If enabled, you are able to view your mailbox folders 

(as created in Outlook or Notes) and any e-mails in these folders on the device. 

This screen contains settings which act as default settings for all folders. From this 

screen you can also force the default settings on all mailbox folders.  

In the Folders screen, you can apply different settings to individual folders (see 

Setting folder options on page 30). In the individual folder setup screen, you can also 

flush the individual settings and re-apply the default settings, which are made in this 

screen. 

 Folders sync. 

In this field you can choose to enable synchronization of e-mails in subfolders by 

default. The e-mails are synchronized for the number of days specified in the Days 

back field. You can change the setting for individual e-mail folders (see Setting 

folder options on page 30). 

Regardless of this setting, the folder structure as such (without e-mails) is 

synchronized between the collaboration system and the device. You need the 

folder structure when choosing where to search for e-mails on the server - see 

E-mails (on server) on page 49 and for moving e-mails to other folders. 

 Days back 

In this field you can specify how many days back the DME client should 

synchronize e-mails in subfolders. Note that with higher numbers, the load on the 

DME server will increase. This number may be changed for individual folders. 

 Apply to all folders now 

This option will always be off when you open the folder settings tab. Think of this 

option as an action button - if you select it, the settings for Days back and Sync. 

folders made in this window will be applied to all folders instantly, regardless of 

their individual settings. This is a way to realign all folder settings with default 

values. 
 

Calendar settings 
In the calendar settings, you specify the synchronization and other aspects of calendar 

items in the DME client on your device. 

 Calendar sync. 

If you select Enabled, calendar synchronization is enabled. This setting affects 

push notification, calendar pull, manual synchronization, and scheduled sync. 

If you select Disabled, calendar items are never synchronized. 

 Calendar mode (current mode) 

With this setting, you can change the security level of the DME Calendar's 

interaction with the native calendar on your device (requires DME Server 3.5). 

There are three options: 
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 Open: Calendar entries from DME are shown in the native calendar. Entries 

from the native calendar are synchronized with DME. 

 Mixed: As Open, but potentially sensitive information (that is: Subject, Body, 

and Location) in the native calendar is replaced by a DME security message, 

saying that the fields can only be viewed in the DME calendar. The fields 

mentioned are furthermore encrypted before they are saved to the device disk. 

Choose this setting if you want high security, but you also want to make use of 

calendar alarms. 

 Secure: There is no interaction between DME and the native calendar. 

Note that with this setting, calendar alarms are also disabled. 

When you change this setting, it will not take effect until you have synchronized 

the device. If the current mode (shown after the Calendar mode label) is different 

from your selection, you need to synchronize the device for the setting to take 

effect.  

For more information, see Interaction with native calendar on page 52. 

 Days back 

When items are synchronized, items from the last number of days selected here 

will be synchronized and available in the device. See To-do for more information. 

 Days forward 

When items are synchronized, items up until the number of days selected here will 

be synchronized and available in the Calendar. 

 Calendar pull 

If you select Enable, client-initiated (pull) synchronization of calendar items is 

enabled. This corresponds to the Scheduled sync. see "Scheduled sync. settings" 

on page 74, but is independent of the synchronization schedule set up on the DME 

server. 

Select Disable to disable the client-initiated sync. of calendar items. 

Note that this feature may be disabled if you are roaming. For more information, 

see Roaming on page 19. 

 Pull interval 

If Calendar pull is enabled, the client will initiate a sync. every number of 

minutes selected here. 

 Start time 

In this field you can specify the time of day after which client-initiated pull 

should start, if this is enabled. Use the local time format, for instance 

hh:mm:ss or hh:mm:ss am/pm. Example: 08:00 or 08:00 am. 

 End time 

In this field you can specify the time of day at which client-initiated pull 

should end, if this is enabled. Use the local time format, for instance hh:mm:ss 

or hh:mm:ss am/pm. Example: 17:30 or 05:30 pm. 

 Run on weekends 

If you select Yes, client-initiated pull will continue to run over the weekend. 

If you select No, client-initiated pull will not run on weekends. 
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Contacts sync. settings 
 Contacts sync. 

If you select Enabled/On, contact synchronization is enabled, and your list of 

contacts on the device will be kept in sync with your personal address book on the 

collaboration system. 

If you select Disabled/Off, contacts are never synchronized. 
 

To-do settings 
 To-do sync. 

If you select Enabled, to-do item synchronization is enabled. This setting affects 

push notification, manual synchronization, and scheduled sync. 

If you select Disabled, to-dos are never synchronized. 

 Days back 

When to-dos are synchronized, items from the selected number of days back in 

time will be synchronized and available in the device. See To-do for more 

information. 

 Days forward 

When to-dos are synchronized, items with a date up until the selected number of 

days ahead in time will be synchronized and available in the device. 
 

Files settings 
With this setting, you enable or disable the synchronization of files. File 

synchronization requires a special license and is set up on the DME server. For more 

information, please ask your DME administrator. 

 File sync. 

If you select Enabled, file synchronization is enabled. This setting affects push 

notification, manual synchronization, and scheduled sync. 

If you select Disabled, files are never synchronized. 
 

Scheduled sync. settings 
With these settings, you specify options for scheduled synchronization. Note that this 

feature may be disabled if you are roaming. For more information, see Roaming on 

page 19. 

 Scheduled sync. 

If you select Enabled, the DME client will initiate synchronization of the enabled 

resources (e-mail, calendar, etc.) according to the schedule specified below. 

If you select Disabled, the synchronization of resources relies on client-initiated 

sync (pull, where applicable), manual synchronization, or push notification from 

the mail system. 

 Interval 

If Scheduled sync. is enabled, the client will accept a sync. every number of hours 

selected here. Permitted range: 1-24 hours. 
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 Start time 

In this field you can specify the time of day after which scheduled sync. should 

start, if this is enabled. Use the local time format, for instance hh:mm:ss or 

hh:mm:ss am/pm. Example: 08:00 or 08:00 am. 

 End time 

In this field you can specify the time of day at which scheduled sync. should end, 

if this is enabled. Use the local time format, for instance hh:mm:ss or hh:mm:ss 
am/pm. Example: 17:30 or 05:30 pm. 

 Run on weekends 

If you select Yes, scheduled sync. will continue to run over the weekend. 

If you select No, scheduled sync. will not run on weekends. 
 

Shortcuts settings 
In this screen, you can change the shortcuts defined for your device. For each of the 

ten fields in this screen (*0 - *9), you can select one of the available options: 

Shortcut option Action 

<blank> Removes any existing shortcut definition. The shortcut will do 

nothing. 

Sync. e-mail Synchronize e-mail. 

New e-mail Create a new e-mail. 

Open inbox Open the Inbox. 

View folders Open the Folders screen to change to another e-mail folder. 

Open calendar Open the internal DME calendar. 

Open contacts Open the Contacts application. 

Global Address Book Search the Global Address Book to find a contact. 

Search e-mails Search for e-mails on the collaboration system. 

Mark read Mark selected e-mail or e-mails as read. 

Mark unread Mark selected e-mail or e-mails as unread. 

Move to folder Move selected e-mail or e-mails to an e-mail folder of your choice. 

New meeting Create a new meeting invitation. 

Sync. calendar Synchronize the calendar according to settings. 

Sync. contacts Synchronize your contacts. 

Sync. to-do Synchronize to-dos according to settings. 

Sync. files Synchronize files according to settings. 

Sync. all Synchronize everything according to settings. 
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For information about how to use shortcuts, see Shortcuts on page 28. 
 

Desktop settings 
 Log in to 

In this field you can specify which screen you want to see after logging in to the 

DME client. You can choose between the following two options: 

 Desktop: DME starts in the Desktop view after logging in. 

 Inbox: DME opens the Inbox after logging in. 

For more information, see Using the DME client on page 27. 

 Background 

In this field you can specify the color of the Desktop background. You can choose 

between the following two options: 

 Dark: The Desktop is shown with a dark background. 

 Light: The Desktop is shown with a light background. 

The background is not affected by your choice of theme on the phone. 

 Startup sound 

If this field is set to Enabled, DME will play a sound when you launch the client. 
 

Menu tree 

If you have access to the full DME client, the menu structure of the DME client is as 

follows. Note that the DME menu structure is dynamic. If your license does not 

include all functionality, or if some functionality is turned off by the DME 

Administrator, there will be less menu items than shown below. 
 

Create 
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Synchronize 
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Actions 

 
 

Search 
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Tools 
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View 

 
 

About DME 
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If you need further assistance 

If you have read this guide and still have questions concerning the function and use of 

the DME client, please contact your DME administrator (usually the internal IT 

department). 

Before contacting your DME administrator, be sure to have information about your 

DME version etc. ready.  

 Showing the current version of your DME client 

1 Open the DME menu (iPhone: tap Tools). 

2 Select About DME. 

 

 

DME keeps a log of the events that take place in the client. 

 Showing the DME client event log 

1 Open the DME menu (iPhone: Go to Desktop or a mailbox folder). 

2 Select Tools / . 

3 Select Log. 

 

 

If you are using the DME client for Windows Mobile, Java, or iPhone, you can tap 

Send log (iPhone: tap ) to insert the log text into a new e-mail, which you can then 

send to your Helpdesk. 

If you are using the DME client for Android, you can tap the Menu key, and tap the 

diskette icon to save the log to the file /sdcard/me/log.txt on the memory card. 
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Please note that the DME administrator can request the client log using a feature in the 

DME Server (not iPhone). 

If you are the DME administrator, you can contact your DME partner. 

You can also check the DME Support http://www.excitor.com website for more 

information. 

If you find errors or omissions in this documentation, please contact Documentation 

feedback see Documentation feedback - 

mailto:documentation@excitor.com?Subject=Documentation feedback. 

 

http://www.excitor.com/
mailto:documentation@excitor.com?Subject=Documentation%20feedback
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List of procedures 

 Substituting password for PIN code ................................................. 12 
 Starting the DME client .................................................................... 23 
 Switching to DME if the client is already running ........................... 23 
 Logging in to DME for the first time ............................................... 25 
 Uninstalling the DME client for Symbian ........................................ 26 
 Opening an attachment ..................................................................... 36 
 Sending an attachment (not by DME secure e-mail) ........................ 37 
 Removing a single attachment ......................................................... 38 
 Removing all attachments from the device ...................................... 38 
 Viewing e-mail details...................................................................... 38 
 Calling a number associated with an e-mail ..................................... 38 
 Creating and sending an e-mail ........................................................ 39 
 Saving an e-mail as a draft ............................................................... 42 
 Setting message options ................................................................... 42 
 Replying to an e-mail ....................................................................... 43 
 Forwarding an e-mail ....................................................................... 43 
 Sending attachments in original e-mails and replies ........................ 44 
 Sending attachments in forwarded e-mails....................................... 45 
 Adding attachments to meeting invitations ...................................... 45 
 Marking one, selected, or all e-mails as read or unread ................... 46 
 Sorting items .................................................................................... 46 
 Deleting one or more selected items ................................................ 47 
 Deleting the currently open e-mail ................................................... 47 
 Moving an item to another folder ..................................................... 47 
 Finding contacts in the global address book..................................... 48 
 Searching for e-mails on the server .................................................. 49 
 Searching for a text string ................................................................ 51 
 Calendar options for the meeting chair ............................................ 55 
 Calendar options for meeting participants ........................................ 57 
 Responding to a meeting invitation .................................................. 57 
 Creating a new meeting .................................................................... 59 
 Entering meeting participants ........................................................... 61 
 Downloading rooms and resources .................................................. 62 
 Selecting rooms and resources ......................................................... 62 
 Checking free time ........................................................................... 63 
 Showing the current version of your DME client ............................ 81 
 Showing the DME client event log .................................................. 81 
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